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AAAAbbbboooouuuutttt    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX
Welcome to Software MacKiev's new Mac OS X edition of Kid Pix! Kid Pix inspires children to express 
their natural creativity with wacky, innovative, and fun art tools.

The Mac OS X Edition of Kid Pix Deluxe 3X has been enhanced to take full advantage of working with 
sound and graphics by easy interaction with Apple’s “iApps“. 

KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    hhhhaaaassss    ttttwwwwoooo    ppppaaaarrrrttttssss::::

• The Paint Zone lets you create pictures with different art tools.

• Slide Show lets you put pictures into a presentation with visual transitions and sounds.

IIIInnnn    tttthhhhiiiissss    cccchhhhaaaapppptttteeeerrrr    yyyyoooouuuu    wwwwiiii llll llll     lllleeeeaaaarrrrnnnn    aaaabbbboooouuuutttt::::

• Kid Pix Deluxe 3X System Requirements

• Getting Started

• Installing Kid Pix CD Contents

• The Kid Pix Deluxe 3X Paint Zone

• The Kid Pix Deluxe 3X Slide Show

• Using the Menus

• Getting Help

• Removing Kid Pix Deluxe 3X

KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    SSSSyyyysssstttteeeemmmm    RRRReeeeqqqquuuuiiiirrrreeeemmmmeeeennnnttttssss    
MMMMiiiinnnniiiimmmmuuuummmm    ssssyyyysssstttteeeemmmm    rrrreeeeqqqquuuuiiiirrrreeeemmmmeeeennnnttttssss::::

• Mac OS X 10.1.5 or later

• Any Macintosh computer with a G3-266 MHz processor or faster

• 256 MB RAM

• 200 MB of free space to install and work with the application (in this case the Kid Pix Deluxe 3 CD 
must be in the CD/DVD drive in order to use the libraries), or about 350 MB for full installation

• 800 x 600 display resolution, thousands of colors (1024 x 768 display resolution and millions of 
colors are recommended)
About Kid Pix Deluxe 3X 6



                                                                         
GGGGeeeettttttttiiiinnnngggg    SSSSttttaaaarrrrtttteeeedddd

TTTToooo    iiiinnnnssssttttaaaallll llll     KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX::::

1. Put the Kid Pix Deluxe 3X CD in the CD-ROM drive. The Kid Pix Deluxe 3X window appears.

2. Double-click the Kid Pix Installer icon. In the window that appears, click the Continue button. 

3. Select either Home or School installation depending on where you use Kid Pix and click 
Continue.

4. Select the installation options you want.

• With Home installation, decide if you want to install only the Kid Pix application or the 
application and its libraries as well.

Note: If you decide not to install the entire Kid Pix Deluxe 3X CD contents, only part of the 
contents will be installed on your hard disk. The rest of the contents (backgrounds, stickers, 
animations, stamps, and sounds) can be used from the CD. You can always install the entire 
Kid Pix CD contents later. For more information, see "Installing Kid Pix CD Contents" on page 8.

• With School installation, you can turn on or off the Login dialog, the startup movie, and the 
update notifications in Kid Pix. The application libraries are always installed.

Note: You can always change these settings later by using the Kid Pix Preferences dialog. 
For more information, see "Setting Up Kid Pix Preferences" on page 61.

5. Click Continue and wait until the installation is completed. Then click Register to register Kid 
Pix if you are online, or click Done to register later if you are not.

TTTToooo    llllaaaauuuunnnncccchhhh    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX::::

1. In the Applications folder, which automatically opens after installation, double-click the 
Kid Pix Deluxe 3X icon. 

Tip: To find Kid Pix quickly in future, drag the application icon to the Dock.
About Kid Pix Deluxe 3X7



                                                         
TTTToooo    rrrreeeeggggiiiisssstttteeeerrrr    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX::::

Register your copy of Kid Pix to be notified about product updates and news.

You can register your copy of Kid Pix by choosing the Kid Pix Registration command from the Kid Pix 
application menu.

TTTToooo    lllloooogggg    iiiinnnn    ttttoooo    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX::::

When you launch Kid Pix Deluxe 3X, the Log In dialog appears.

1. Type your name in the box labeled “Enter your name here”.
2. Click GO to open Kid Pix Deluxe 3X.

From now on, your name will be in the “Select your name here” list and you can double-click it to 
start using Kid Pix. For details on adding more users, see "Setting Up Multiple Users" on page 63.

Note: You can turn the Login dialog off using the Kid Pix Preferences dialog. For more information, 
see "Turning Off the Login Dialog" on page 63.

IIIInnnnssssttttaaaallll llll iiiinnnngggg    KKKKiiiidddd    PPPPiiiixxxx    CCCCDDDD    CCCCoooonnnntttteeeennnnttttssss

If you do not want to use the CD while working with the application, you can install all Kid Pix CD 
contents on your hard disk. 

TTTToooo    iiiinnnnssssttttaaaallll llll     KKKKiiiidddd    PPPPiiiixxxx    CCCCDDDD    ccccoooonnnntttteeeennnnttttssss::::

1. Launch Kid Pix by double-clicking the Kid Pix Deluxe 3X icon located in the Applications folder.

2. Log in to Kid Pix using the Login dialog. 

3. Choose Install Kid Pix CD Contents from the Kid Pix application menu on the menu bar. For 
information on displaying the menu bar, see "Using the Menus" on page 11.
About Kid Pix Deluxe 3X 8



    
TTTThhhheeee    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    PPPPaaaaiiiinnnntttt     ZZZZoooonnnneeee
After logging in to Kid Pix Deluxe 3X, you will see the Paint Zone. For more information on using 
the Paint Zone, see "Working with Pictures" on page 47.

Library Tools

Undo Guy

Tools

Color Swatch Tool Picker Options Tray Go to Slide Show

Extended Help

Print

Quit

Firehose Screen Eraser

Create New Picture

Save

Play Picture

Drawing Area

Paper Texture Canister
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TTTThhhheeee    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can make a Slide Show with your pictures. For more information on using Slide Show, 
see "Working with Slide Show" on page 51.
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Create New Slide Show

Customize
Slide Show Effects

Print

Save 
Slide 
Show

Play Slide Show

Go to Paint ZoneSaved Slide Shows Trash Can

Extended 
Help

Undo 
Guy

Slide

Slide Show Title Slide Name

Show More Saved Slide Shows

Show 
Next 
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Show 
Previous 
Row
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UUUUssssiiiinnnngggg    tttthhhheeee    MMMMeeeennnnuuuussss
Kid Pix Deluxe 3X has menus you can display and use. For a full list of all the menu commands,
see "The Kid Pix Deluxe 3X Menus" on page 65.

TTTToooo    ddddiiiissssppppllllaaaayyyy    tttthhhheeee    mmmmeeeennnnuuuussss::::

1. Position the pointer at the very top of the screen by moving your mouse.

2. When you see a black triangle outlined in white, make a single click. The menu bar will 
appear.

3. Click the desired menu title to open it, then click the command you want to choose.

GGGGeeeettttttttiiiinnnngggg    HHHHeeeellllpppp
In the Paint Zone and the Slide Show, you can find out about items on the screen. There are different 
types of help available: extended help, coaching help, help tags, and the User’s Guide.

EEEExxxxtttteeeennnnddddeeeedddd    HHHHeeeellllpppp

1. Click the Extended Help button.

2. Move the pointer over the items you want help with.

3. Read and listen to the help message. Wait for a few seconds to hear the message again. 
Move the pointer away and the current help message will disappear.

4. Click once anywhere to leave the Extended Help mode.

CCCCooooaaaacccchhhhiiiinnnngggg    HHHHeeeellllpppp

If there is no mouse or keyboard activity for a certain period of time, you will get tips telling you how to 
use the currently selected tool. A voice reads the helpful tips out loud. You can set the period of time 
after which Coaching Help starts. For details, see "Setting Up Kid Pix Preferences" on page 61.

HHHHeeeellllpppp    TTTTaaaaggggssss

You will see and hear helpful explanations when you place your pointer over any tool or button for a 
few seconds. Help tags are turned on when you launch Kid Pix for the first time. For details on 
additional help tag settings, see "Setting Up Kid Pix Preferences" on page 61.

TTTToooo    ttttuuuurrrrnnnn    hhhheeeellllpppp    ttttaaaaggggssss    ooooffffffff     aaaannnndddd    oooonnnn::::

1. To turn help tags off, choose Turn Help Tags Off from the Help menu. The command 
automatically changes to Turn Help Tags On.

2. To turn help tags on, choose Turn Help Tags On from the Help menu. The command 
automatically changes back to Turn Help Tags Off.
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KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    UUUUsssseeeerrrr’’’’ssss    GGGGuuuuiiiiddddeeee

1. From the Help menu, choose Kid Pix User Guide.

2. Read or print the information.

RRRReeeemmmmoooovvvviiiinnnngggg    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX

TTTToooo    rrrreeeemmmmoooovvvveeee    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    ffffrrrroooommmm    yyyyoooouuuurrrr    ccccoooommmmppppuuuutttteeeerrrr::::

1. Drag the Kid Pix Deluxe 3X application to the Trash. (The application is located in the main 
Applications folder on the system disk.)

2. Drag the Kid Pix Users folder to the Trash. (The folder is located inside the current user’s 
Documents folder.)

Note: If you chose the Skip the Login dialog option during installation of Kid Pix, the Kid Pix 
Users folder does not exist.

3. Drag the com.mackiev.kidpix.plist file to the Trash. (This file is stored in the Preferences 
folder which is located in the current user’s Library folder.)

4. Drag the Kid Pix Deluxe 3X folder to the Trash. (The folder is stored in the Shared folder which 
is located in the Users folder.)

5. Drag the Software MacKiev folder to the Trash. (The folder is located inside the Application 
Support folder in the current user’s Library folder.)

6. If you have placed the Kid Pix Deluxe 3X icon in the Dock, drag it out.

7. Empty the Trash.
About Kid Pix Deluxe 3X 12



UUUUssssiiiinnnngggg    tttthhhheeee    AAAArrrrtttt     TTTToooooooollllssss
In this chapter you will learn about:

• Using Drawing Tools

• Using Painting Tools

• Using Paint Bucket Tools

• Using Mixer Tools

• Using Rubber Stamp Tools

• Using Paper Textures

• Using Color Swatch and Eye Dropper

• Using Eraser Tools

• Using Undo Guy

UUUUssssiiiinnnngggg    DDDDrrrraaaawwwwiiiinnnngggg    TTTToooooooollllssss
Use Kid Pix Drawing Tools to draw different kinds of lines and shapes. There are four drawing tools: 
Pencil, Chalk, Crayon, and Marker. You can draw freestyle, straight or curved lines, rectangles, circles, 
or polygons.

TTTToooo    ddddrrrraaaawwww::::
1. Click the Drawing Tools button.

2. Pick a tool.

3. Select a thickness for the line.

4. Select a shape or a line type.

5. Click in the drawing area and, holding down the mouse button, move the mouse around to 
draw.

Chalk
(soft/fuzzy)

Marker
(see-through)

Pencil 
(solid)

Crayon
(hard/fuzzy)

Line 
Thickness

Freestyle 
Line

Curved 
Line

Straight
Line

Box 
Outline

Circle 
Outline

Shape 
Outline

Filled 
Box

Filled 
Circle

Filled 
Shape
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For rectangles, circles, and polygons, you can draw either a filled or an outline shape. Outlines 
let the background show through.

• To draw a curve, click the Curved line and click in the drawing area in the place where 
you want to start drawing a curve. Holding down the mouse button, draw a straight line. 
Release the mouse button and move the pointer over the line to bend it to the curve you 
want, then click again.

• To draw a polygon, click the Shape outline or Filled shape. Draw the sides, clicking at 
the end of each one. Finish by clicking the starting point again.

DDDDrrrraaaawwwwiiiinnnngggg    TTTTiiiippppssss
• If you change the paper texture and then draw with the Crayon, Chalk, or Marker, the texture 

shows through under your drawing. For more information on using paper texture, see "Using 
Paper Textures" on page 20.

• To draw vertical and horizontal lines, or squares and circles, press the Shift key while drawing.

UUUUssssiiiinnnngggg    PPPPaaaaiiiinnnnttttiiiinnnngggg    TTTToooooooollllssss
Use Kid Pix Painting Tools for a dazzling array of realistic and out-of-this-world painting effects. There 
are three different tools: Paint Brush, Sound Art tool, and Spray Can. Each tool has two modes.

TTTToooo    ppppaaaaiiiinnnntttt::::
1. Click the Painting Tools button.

2. Click Paint Brush, Sound Art, or Spray Can.

See the next few pages for more information about each kind of tool.

3. Select a size (not every tool has a size selection).

4. Select a painting mode.

When you pick a mode, the options change.

5. Select a painting option.

6. Click the arrows at the right side of the tray to see more painting options.

7. Click the drawing area and, holding down the mouse button, move the mouse around to 
paint.

PPPPaaaaiiiinnnntttt     BBBBrrrruuuusssshhhh
Click Paint Brush and select a brush size and painting mode. In the Realistic Paint mode you can 
paint like with a real brush.

Paint Brush Paint Brush Size

Show Realistic Paint Options

Paint Style Options

Show Previous Row

Show Next Row

Row Number
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The Wacky Paint mode creates magical effects.

Note: Most of the Wacky Paint options change their drawing style when you press the Shift, Option, or 
Command keys while drawing.

TTTThhhheeee    SSSSoooouuuunnnndddd    AAAArrrrtttt     TTTToooooooollll
To use the Sound Art tool, you need to talk, sing, or play music into a built-in microphone or one 
attached to your computer. The “Mouse-move” mode lets you direct the painting with your mouse.

The “Hands-free” mode lets the sound do the painting.

Note: If this tool does not work properly, make sure you have your microphone connected and that 
the corresponding device is selected in the Input pane of the Sound dialog of System Preferences.

Show Wacky Paint Options

Mouse-Move Mode

Sound Art Tool

Hands-Free Mode
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SSSSpppprrrraaaayyyy    CCCCaaaannnn

The Paint Shapes mode sprays three-dimensional shapes: balloons, bugs, candies, and so on. 

The Moving Paints mode sprays balloons, bubbles, and creatures that dance, fly, hop, or wiggle.

PPPPaaaaiiiinnnnttttiiiinnnngggg    TTTTiiiippppssss

• Experiment with Painting Tools, modes, and options. Try lots of different combinations.

• For information on adding text in the Wacky Paint mode, see "Alphabet Text Tool" on page 23. 

• Some of the Realistic Paint options of the Paint Brush tool let a paper texture show through. 
For more about paper texture, see "Using Paper Textures" on page 20.

UUUUssssiiiinnnngggg    PPPPaaaaiiiinnnntttt     BBBBuuuucccckkkkeeeetttt     TTTToooooooollllssss
Paint Buckets let you fill up an area of your picture. There are three kinds of Paint Bucket Tools. Single 
Color Paint Bucket fills an area with one solid color or a single-color pattern. Blend of Colors Paint 
Bucket fills an area with a blend of colors. Multicolor Pattern Paint Bucket fills an area with a multicolor 
pattern.

TTTToooo    ffffiiii llll llll     aaaannnn    aaaarrrreeeeaaaa::::
1. Click the Paint Bucket Tools button to see the Paint Buckets tray. 

2. Pick a bucket from the left side of the tray.

3. Select a fill option from the right side of the tray. You can click the scrolling arrows to see 
more fill options.

4. Click inside the area you want to fill.

Spray Can

Show Paint Shapes Options

Show Moving Paints Options
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The Single Color Paint Bucket uses the current color in the Color Swatch. Select solid 
color or one of the single-color patterns. 

The Blend of Colors Paint Bucket does not use the current color in the Color Swatch. You can 
pick any of the blends to use in your painting.

The Multicolor Pattern Paint Bucket does not use the current color in the Color Swatch. You 
can pick any of the multicolored patterns to use in your painting.

FFFFiiii llll llll     TTTTiiiippppssss

• If you fill with the Blend of Colors Paint Bucket, position the pointer on your picture and click 
and hold the mouse button down while the blend effect appears. Then, without releasing the 
mouse button, you can move the mouse around to change how the blend colors appear inside the 
area on your picture.

• You can design your own two-color patterns. Fill an area with a solid color, then change the color 
in the Color Swatch and fill the same area with a single-color pattern.

• For information on changing the color for the Single Color Paint Bucket, see "Using Color Swatch 
and Eye Dropper" on page 20.

Single Color Paint Bucket Paint Bucket Fill Options

Solid Color Fill Option
Show Previous Row

Show Next Row
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Blend of Colors Paint Bucket

Multicolor Pattern Paint Bucket
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UUUUssssiiiinnnngggg    MMMMiiiixxxxeeeerrrr    TTTToooooooollllssss
Mixers mix up your picture. You can mix up the whole painting with the Mega Mixer, or just parts of the 
picture with the Mixer Wand.

TTTToooo    mmmmiiiixxxx    tttthhhhiiiinnnnggggssss    uuuupppp::::
1. Click the Mixer Tools button to see the Mixers tray.

2. Pick the Mega Mixer or the Mixer Wand from the left side of the tray. The Mega Mixer 
mixes up the whole picture with one click; the Mixer Wand mixes the places where you 
drag it.

3. Select a mixer effect from the right side of the tray. You can click the scrolling arrows to see 
more effects.

4. Select a mixer effect size.

5. Click your picture with the Mega Mixer or drag the Mixer Wand to mix areas on your picture. 

MMMMiiiixxxxeeeerrrr    TTTTiiiippppssss

• Mix up an imported photograph for fun results. For information on importing photos, see "Adding 
Pictures" on page 39.

• You can change the size only for some Mega Mixer effects. The size of the Mega Mixer influences 
the intensity of the mixer effect.

UUUUssssiiiinnnngggg    RRRRuuuubbbbbbbbeeeerrrr    SSSSttttaaaammmmpppp    TTTToooooooollllssss
Use the Rubber Stamp Tools to stamp different images onto your picture.

TTTToooo    uuuusssseeee    RRRRuuuubbbbbbbbeeeerrrr    SSSSttttaaaammmmpppp    TTTToooooooollllssss::::
1. Click the Rubber Stamp Tools button to see the Rubber Stamps tray.

Mega Mixer Mixer Wand Mixer Effect Size Mixer Effect Preview
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List of Categories Sizes Rubber Stamp Preview

Stamp Editor Show Previous Row
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2. Choose a category from the pop-up list. Click the arrows at the right side of the pop-
up list to scroll through the list of stamp categories.

3. Select a size for your rubber stamp.

4. Select a rubber stamp, then click your picture.

EEEEddddiiiittttiiiinnnngggg    RRRRuuuubbbbbbbbeeeerrrr    SSSSttttaaaammmmppppssss

You can edit rubber stamps.

TTTToooo    eeeeddddiiiitttt     rrrruuuubbbbbbbbeeeerrrr    ssssttttaaaammmmppppssss::::
1. Click the Rubber Stamp Tools button to see the Rubber Stamps tray.

2. Click the stamp you want to edit.

3. Click the Stamp Editor button to open the Stamp Editor.

Note: Alternatively, you can open the Stamp Editor by double-clicking the stamp you 
want to edit in the Rubber Stamps tray.

Use these tools to change your stamp:

• Use Pencil to draw on the stamp.

• Pick a color in the Color Picker and use Fill Bucket to recolor the stamp.

• Click Rotate to turn the stamp 90 degrees clockwise. You can do this several times.

• Click Flip Horizontal to turn your stamp over from left to right, giving you a mirror-
image.

• Click Undo/Redo to undo or redo your last action, or click Restore Original to go back 
to the original stamp view.

• Use Eraser to erase the whole stamp so you can start from scratch.

4. Click OK when you are finished.

Undo/Redo

Flip Horizontal

Pencil

Fill Bucket

Eraser

Rotate

Stamp 
Preview

Color 
Picker
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UUUUssssiiiinnnngggg    PPPPaaaappppeeeerrrr    TTTTeeeexxxxttttuuuurrrreeeessss
You can change the background texture of your Kid Pix picture. Then, when you draw with the Crayon, 
Marker, Chalk, or use some of the Realistic Paint options of the Paint Brush tool, a pattern will 
show through under your drawing.

TTTToooo    cccchhhhaaaannnnggggeeee    aaaa    ppppaaaappppeeeerrrr    tttteeeexxxxttttuuuurrrreeee::::
1. Click the Paper Texture Canister in the bottom-right corner of the Drawing Area. 

The Paper Textures tray opens.

2. Scroll through the paper textures in the tray.

3. Click the texture you want.

You can see the texture you have selected on the Paper Texture Canister.

4. Draw with Crayon, Marker, Chalk, or with some of the Realistic Paint options of the Paint 
Brush tool to see the texture in your picture.

UUUUssssiiiinnnngggg    CCCCoooolllloooorrrr    SSSSwwwwaaaattttcccchhhh    aaaannnndddd    EEEEyyyyeeee    DDDDrrrrooooppppppppeeeerrrr
Many Kid Pix art tools use the color you choose from the Color Picker. You can see the current color in 
the Color Swatch at the bottom-left corner of the Paint Zone and on many art tools. 

The Color Picker also includes Eye Dropper, a tool that lets you pick up and use any color in your picture 
that isn’t in the Color Picker.

TTTToooo    ppppiiiicccckkkk    aaaa    ccccoooolllloooorrrr    iiiinnnn    tttthhhheeee    CCCCoooolllloooorrrr    PPPPiiiicccckkkkeeeerrrr::::

1. Position the pointer over the Color Swatch. The Color Picker pops up.

2. Click a color in the Color Picker. As soon as you pick a color, the Color Swatch 
changes to show your new choice. Move the pointer out of the Color Picker to close it 
and continue working with Kid Pix.

Eye Dropper

Colors 
Palette
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TTTToooo    ppppiiiicccckkkk    uuuupppp    aaaa    ccccoooolllloooorrrr    wwwwiiiitttthhhh    tttthhhheeee    EEEEyyyyeeee    DDDDrrrrooooppppppppeeeerrrr::::

1. Open the Color Picker by positioning the pointer over the Color Swatch.

2. Click the Eye Dropper.
3. Move the Eye Dropper over the screen. As the pointer moves, the Color Swatch changes to 

show colors that the Eye Dropper can pick up.
4. Click when the color you want appears in the Color Swatch. The Color Picker closes. The 

color you have clicked becomes the current color for the selected tool.

UUUUssssiiiinnnngggg    EEEErrrraaaasssseeeerrrr    TTTToooooooollllssss
Big Eraser erases your whole picture. You can also click the Firehose Screen Eraser to 
clear the drawing area. Mini Eraser erases the places where you drag it, leaving white 
space. You cannot erase stickers, animations, movies, or text boxes with Mini Eraser. 
(To remove these objects, select them using the Grab Hand tool in the Grab tray and 
press the Delete key.)

TTTToooo    eeeerrrraaaasssseeee    yyyyoooouuuurrrr    wwwwhhhhoooolllleeee    ppppiiiiccccttttuuuurrrreeee::::
1. Click the Eraser Tools button. The Erasers tray appears.

2. Click Big Eraser.
3. Pick an eraser effect option. You can click the scrolling arrows to see more effects.
4. Click your picture.

TTTToooo    eeeerrrraaaasssseeee    aaaa    ppppaaaarrrrtttt     ooooffff     yyyyoooouuuurrrr    ppppiiiiccccttttuuuurrrreeee::::
1. Click the Eraser Tools button. The Erasers tray appears.

2. Click Mini Eraser.
3. Select a size for the eraser.
4. Pick one of these shapes:

• To erase with a round outline, click the circle shape.
• To erase with a square outline, click the square shape.

5. Drag the eraser in the places you want to erase.

UUUUssssiiiinnnngggg    UUUUnnnnddddoooo    GGGGuuuuyyyy
Click Undo Guy whenever you do something to your picture or Slide Show that you do not 
want to keep. Click again to redo what you just have undone.

Mini Eraser Big Eraser Eraser Size

Eraser Shapes

Eraser Effect Options

Show Previous Row

Show Next Row

Row Number
Using the Art Tools21



UUUUssssiiiinnnngggg    tttthhhheeee    TTTTeeeexxxxtttt     TTTToooooooollllssss
In this chapter you will learn about:

• Adding Text

• Working With Text Boxes

• Changing the Way the Letters Look

• Checking Spelling

• Checking Spelling As You Type

• Reading Text Out Loud

AAAAddddddddiiiinnnngggg    TTTTeeeexxxxtttt
There are three ways to add text:

• Insert a text box and type text in it.

• In Small Kids Mode, add rubber stamp characters to the picture.

• Use the Letters Wacky Paint option to paint wacky text onto your picture.

AAAAddddddddiiiinnnngggg    TTTTeeeexxxxtttt     BBBBooooxxxxeeeessss
When text is in a text box, you can check its spelling and make your computer read it out loud.

TTTToooo    aaaadddddddd    aaaa    tttteeeexxxxtttt     bbbbooooxxxx::::

1. Click the Text Tools button. The Text tray appears.

2. Click your picture where you want a text box to appear. 

3. Start typing. The text box will grow as you fill it up. 

TTTToooo    ccccuuuutttt,,,,     ccccooooppppyyyy,,,,     oooorrrr    ppppaaaasssstttteeee    tttteeeexxxxtttt ::::

1. Select the text within the text box.

2. Do one of the following:

• To cut out the text you have selected and copy it to the Clipboard, click the Cut button in 
the Text tray.

• To copy the text you have selected to the Clipboard, click the Copy button in the Text 
tray.

• To paste the text you have cut or copied, place the I-beam pointer in the text box where 
you want your pasted text to appear and click the Paste button in the Text tray.

Formatting Options

Cut

Read Out Loud List of VoicesCopy

Paste 
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TTTTeeeexxxxtttt     iiiinnnn    SSSSmmmmaaaallll llll     KKKKiiiiddddssss    MMMMooooddddeeee

In Small Kids Mode, adding text is like using rubber stamps. Characters become a part of the 
background. You cannot check spelling, change the text appearance (except the color), or make your 
computer read the text out loud, but Kid Pix says the characters’ names when you click them in the 
Text tray. See "Activating Small Kids Mode" on page 64.

TTTToooo    aaaadddddddd    tttteeeexxxxtttt     iiiinnnn    SSSSmmmmaaaallll llll     KKKKiiiiddddssss    MMMMooooddddeeee::::

1. Choose Turn Small Kids Mode On from the Kid Pix application menu.

2. Click the Text Tools button. The Text tray appears.

3. Click a character in the tray to hear its name. (To see more characters, click the scrolling 
arrows at the right side of the Text tray.)

4. Click your picture to add the character.

AAAAllllpppphhhhaaaabbbbeeeetttt     TTTTeeeexxxxtttt     TTTToooooooollll
Alphabet Text becomes a part of the background. You cannot change it after you add it to your picture.

TTTToooo    uuuusssseeee    tttthhhheeee    AAAAllllpppphhhhaaaabbbbeeeetttt     TTTTeeeexxxxtttt     ttttoooooooollll ::::

1. Choose Alphabet Text from the Paint Zone menu. The Alphabet Text dialog appears.

2. Type your text in the box. (The text you type will appear in the drawing area when you use the 
Letters Wacky Paint option of the Paint Brush tool.)

3. Click OK.
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Show Next Row

Row Number
Using the Text Tools23



4. Click the Painting Tools button and select Paint Brush.

5. Switch to the Wacky Paint mode and choose the Letters Wacky Paint option.

6. Click the drawing area and drag the pointer over it. The text you have typed in the 
Alphabet Text dialog appears, following the pointer movements.

WWWWoooorrrrkkkkiiiinnnngggg    wwwwiiiitttthhhh    TTTTeeeexxxxtttt     BBBBooooxxxxeeeessss
You can resize a text box, move it, or delete it.

TTTToooo    cccchhhhaaaannnnggggeeee    aaaa    tttteeeexxxxtttt     bbbbooooxxxx::::
1. Click the Grab Tools button. The Grab tray appears.

2. Click the Grab Hand tool.

3. Click a text box to see its edit frame.

4. Do any of these things:

• To move a text box, simply drag it. Alternatively, you can move text boxes by pressing 
Shift+arrow key or Option+Shift+arrow key on your keyboard.

• To change the size or shape of a text box, drag one of the Scale handles. The text adjusts to 
the new shape.

• To remove the selected text box, press the Delete key on your keyboard.

• To “flatten” text so it becomes a part of background, click the Text button, open the Paint 
Zone menu, click Flatten Text, and choose whether you want to flatten all your text boxes or 
just the selected one.

Paint Brush Letters Wacky Paint OptionShow Wacky Paint Options

Grab Hand Tool Cut

Copy

Paste

Scale
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Scale
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TTTTeeeexxxxtttt     BBBBooooxxxx    TTTTiiiippppssss

• You can drag text boxes almost all the way off the page. This lets you play text out loud without 
having text boxes appear in the picture.

• You can move and resize a text box without using the Grab Hand tool. Drag the blue strip at the 
top of the box frame to move the text box, or drag the handles to resize it.

CCCChhhhaaaannnnggggiiiinnnngggg    tttthhhheeee    WWWWaaaayyyy    tttthhhheeee    LLLLeeeetttttttteeeerrrrssss    LLLLooooooookkkk
You can change the font, font size, color, and style of your text in a text box. In Small Kids Mode, you 
can only change the characters’ color.

Note: Kid Pix Deluxe 3X allows you to apply different styles, fonts, font sizes, and colors to different 
characters in a single text box.

TTTToooo    cccchhhhaaaannnnggggeeee    tttthhhheeee    llllooooooookkkk    ooooffff     tttthhhheeee    sssseeeelllleeeecccctttteeeedddd    tttteeeexxxxtttt     iiiinnnn    aaaa    tttteeeexxxxtttt     bbbbooooxxxx::::
1. Click the Text Tools button to see the Text tray.

2. In a text box, select all the text or a part of the text you want to change the look of.

3. Do any of these things:

• To change the font, click the arrows next to the Font Name menu.

• To make the text bigger or smaller, click the arrows next to the Font size 
menu.

• To change the style, click the Bold, Italic, or Underline buttons.

• To line up your text to the left, right, or center, click the appropriate Text 
alignment button.

Note: Alignment is applied to the whole text in a text box.

• Use the Color Picker to change the color of the text.

CCCChhhheeeecccckkkkiiiinnnngggg    SSSSppppeeeellll llll iiiinnnngggg
When Kid Pix checks spelling, it checks all the text boxes in the drawing area. You cannot check the 
spelling of rubber stamps and alphabet text.

TTTToooo    cccchhhheeeecccckkkk    ssssppppeeeellll llll iiiinnnngggg::::

1. Click the Text Tools button. The Text tray appears.

2. Open the Edit menu.

3. Choose Check Spelling.
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4. If Kid Pix finds a word it does not know, you can do any of these things:

• To change the word, select a word from the Suggestions list or type a word in the Change to 
box and click Change.

• To add an unknown word to the dictionary, click Learn.

• To continue spell-checking without changing the word, click Skip.

5. When you are finished, click Done.

Note: You can also check the spelling of a word by Control-clicking it. A shortcut menu appears 
showing you variants for the word if it has been misspelled.

CCCChhhheeeecccckkkkiiiinnnngggg    SSSSppppeeeellll llll iiiinnnngggg    AAAAssss    YYYYoooouuuu    TTTTyyyyppppeeee
This feature provides a dynamic spelling check while you are typing so that you can be sure that all the 
words you type are spelled correctly. All misspelled words will be underlined with a red dotted line. 

TTTToooo    ttttuuuurrrrnnnn    tttthhhheeee    CCCChhhheeeecccckkkk    SSSSppppeeeellll llll iiiinnnngggg    AAAAssss    YYYYoooouuuu    TTTTyyyyppppeeee    ooooppppttttiiiioooonnnn    oooonnnn::::

1. Open the Edit menu.

2. Choose Check Spelling As You Type so that a checkmark appears. 

RRRReeeeaaaaddddiiiinnnngggg    TTTTeeeexxxxtttt     OOOOuuuutttt     LLLLoooouuuudddd
You can “play” a picture to hear all your text read out loud, from top to bottom and left to right. You 
can’t hear rubber stamps or alphabet text, except when you click each rubber stamp character in the 
Text tray in the Small Kids Mode.

TTTToooo    hhhheeeeaaaarrrr    oooonnnneeee    tttteeeexxxxtttt     bbbbooooxxxx    rrrreeeeaaaadddd    aaaalllloooouuuudddd::::

1. Click the Text Tools button to see the Text tray.

2. Select the text box you want to hear.

3. Click the Read out loud button in the Text tray.

TTTToooo    hhhheeeeaaaarrrr    aaaallll llll     tttteeeexxxxtttt     bbbbooooxxxxeeeessss    rrrreeeeaaaadddd    aaaalllloooouuuudddd::::

1. Click the Play button.

CCCChhhhaaaannnnggggiiiinnnngggg    VVVVooooiiiicccceeee

You can use the List of Voices menu in the Text tray to change the voice that reads the text.

TTTToooo    cccchhhhaaaannnnggggeeee    tttthhhheeee    vvvvooooiiiicccceeee    tttthhhhaaaatttt     rrrreeeeaaaaddddssss    tttthhhheeee    tttteeeexxxxtttt ::::
1. Click the Text Tools button. The Text tray appears.
Using the Text Tools 26



2. Click the List of Voices pop-up menu and choose the voice from the list. 
Alternatively, you can pick a different voice from the list by clicking the arrows 
next to the menu.

TTTTeeeeaaaacccchhhhiiiinnnngggg    KKKKiiiidddd    PPPPiiiixxxx    ttttoooo    PPPPrrrroooonnnnoooouuuunnnncccceeee

Kid Pix might not know how to say people’s names or other special words.

TTTToooo    cccchhhhaaaannnnggggeeee    tttthhhheeee    pppprrrroooonnnnuuuunnnncccciiiiaaaattttiiiioooonnnn::::

1. Click the Text Tools button.

2. From the Paint Zone menu, choose Say It This Way. The pronunciation dialog appears.

3. In the Original Word box, type the word that Kid Pix is pronouncing incorrectly.

4. In the Pronounce As box, type the phonetic spelling of the word. For example, the letters “ph” 
sound like “f,” so the phonetic spelling of “Philip” would be “Filip”.

5. Click Original to hear the pronunciation of the original word.

6. Click Pronounce to hear the new pronunciation.

7. When the word sounds right, click Enter to apply the new pronunciation.

8. Click Done to close the dialog.
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MMMMoooovvvviiiinnnngggg,,,,     CCCCooooppppyyyyiiiinnnngggg,,,,     CCCCuuuuttttttttiiiinnnngggg,,,,     aaaannnndddd    PPPPaaaassssttttiiiinnnngggg
In this chapter you will learn about:

• The Grab Hand Tool

• The Scissors Tool

GGGGrrrraaaabbbb    HHHHaaaannnndddd
Use Grab Hand to pick objects up and move them, or cut, copy, and paste them.

TTTToooo    mmmmoooovvvveeee    oooobbbbjjjjeeeeccccttttssss    aaaarrrroooouuuunnnndddd::::

1. Click the Grab Tools button. The Grab tray appears.

2. Click the Grab Hand tool.

3. Click a sticker, animation, movie, or text box in your picture to select it.

Note: You can use the Tab key to select an object hidden behind another one.

4. Do any of these things:

• To move the object you have selected, drag it. Alternatively, you can move objects by 
pressing Shift+arrow key or Option+Shift+arrow key on your keyboard.

• To cut the object you have selected and copy it to the Clipboard, click the Cut button in 
the Grab tray.

Note: You cannot cut and copy a selected movie to the Clipboard. The movie will just be 
removed from the picture after you click the Cut button.

• To copy the object you have selected to the Clipboard, click the Copy button in the Grab 
tray.

• To paste something you have cut or copied, click the Paste button in the Grab tray. Drag 
the pasted item to move it wherever you want.

• To get rid of the object you have selected, press the Delete key on your keyboard.

Grab Hand Tool Cut

Copy

Paste 
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SSSScccciiiissssssssoooorrrrssss
Use the Scissors tool to cut out, move, copy, and paste a part of your background.

TTTToooo    ccccuuuutttt     tttthhhhiiiinnnnggggssss    oooouuuutttt::::

1. Click the Grab Tools button. The Grab tray appears.

2. Click the Scissors tool.

3. Do any of these things:

• To select an area freehand, click the Free Cutout style and drag around the area you 
want.

• To select a polygon area, click the Polygon Cutout style and click each point of the 
polygon (at least 3 points). Click the first point again to close the shape.

• To select a circle or an ellipse area, click the Circle Cutout style and, drag the pointer in 
any direction you want to form a circle or an ellipse.

• To select a square or a rectangle area, click the Square Cutout style and, drag the 
pointer in any direction you want to form a square or a rectangle.

• To select a cookie cutter shape area, click a cookie cutter style, then click your picture.

Note: You can use the Shift key to select a regular circle or square area.

4. After selecting an area, you can drag it to the place you want or cut, copy and paste it using 
the Cut, Copy and Paste buttons in the tray.

 Cut Paste 

Copy

Scissors Tool Cutout Styles

Show Previous Row

Show Next Row

Row Number
Moving, Copying, Cutting, and Pasting29



UUUUssssiiiinnnngggg    LLLLiiiibbbbrrrraaaarrrriiiieeeessss
In this chapter you will learn about:

• Using Library Buttons

• The Backgrounds Library

• The Stickers Library

• The Animations Library

• The Sounds Library

UUUUssssiiiinnnngggg    LLLLiiiibbbbrrrraaaarrrryyyy    BBBBuuuuttttttttoooonnnnssss
In Kid Pix libraries you can look in the trays for interesting objects to add to your picture. There are 
four oval buttons at the top-left of the screen. Each one opens a Kid Pix library. 

A background in your picture is like the scenery in a play. It goes behind everything 
else you draw. See "Backgrounds Library" on page 31.

A sticker floats above your picture like a balloon at a parade. You can resize it, flip it, 
or move it to a different place. See "Stickers Library" on page 33.

Animations move around like cartoons when you “play” your picture. You can drag 
them anywhere you like. See "Animations Library" on page 35.

Each picture can have one sound. Pick from a library, record your own, or import any 
available sound. See "Sounds Library" on page 37.

You can also import movies and pictures from other applications to your Kid Pix 
pictures. For more information, see "Adding Pictures" on page 39, "Adding Sounds" on 
page 40, and "Adding Movies" on page 40.

LLLLiiiibbbbrrrraaaarrrryyyy    TTTTrrrraaaayyyyssss    

When you click a library button, the tray for that library appears at the bottom of the screen:

Each library contains a list of categories. For example, if you click the Animations Library button, you 
can choose the Alphabet category from the pop-up menu to see animated letters.

List of Categories Scrolling 
Arrows

Object Preview Object Name
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TTTToooo    uuuusssseeee    aaaa    KKKKiiiidddd    PPPPiiiixxxx    llll iiiibbbbrrrraaaarrrryyyy::::

1. Click the Categories pop-up menu to see a list of categories, or use the scrolling arrows to scroll 
through the categories one by one.

2. Using the scrolling arrows on the right side of the tray, scroll through the objects until you find 
the one you want. Alternatively, you can navigate through the objects in the tray by using the 
arrows keys on your keyboard.

3. Select the object you want and drag it onto the drawing area. Alternatively, you can double-click 
the selected object, or press Return on your keyboard.

BBBBaaaacccckkkkggggrrrroooouuuunnnnddddssss    LLLLiiiibbbbrrrraaaarrrryyyy
Lots of things you draw are added to the background and become a part of it. For example, when you 
draw a line or paint a circle, that shape becomes a part of the background. When you change the 
background, those shapes disappear and the new background takes their place. If you do not like the 
result, click Undo Guy.

TTTToooo    aaaadddddddd    aaaa    bbbbaaaacccckkkkggggrrrroooouuuunnnndddd::::

1. Click the Backgrounds Library button to open the Backgrounds tray. All 
backgrounds are divided into three collections: color backgrounds (including the 
Photos and My Backgrounds categories), line drawing backgrounds and special 
projects, and map backgrounds.

Note: The My Backgrounds category becomes available after you import at least 
one background to it.

2. Select a library collection. 

3. Choose a category from the List of Categories pop-up menu.

4. Scroll through the backgrounds.

5. Add a background to your picture.

TTTToooo    rrrreeeemmmmoooovvvveeee    tttthhhheeee    bbbbaaaacccckkkkggggrrrroooouuuunnnndddd    ffffrrrroooommmm    yyyyoooouuuurrrr    ppppiiiiccccttttuuuurrrreeee::::
1. Click the No background button in the Backgrounds tray.

List of Categories Scrolling 
arrows

Background 
Preview

Color 
Backgrounds

Line Drawing Backgrounds 
and Special Projects

Map Backgrounds

Background Name 

Trash Can

Import 
from iPhoto

No Background
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IIIImmmmppppoooorrrrttttiiiinnnngggg    BBBBaaaacccckkkkggggrrrroooouuuunnnnddddssss

You can import photographs or pictures from iPhoto or the Finder to use them as backgrounds.

TTTToooo    iiiimmmmppppoooorrrrtttt     aaaa    bbbbaaaacccckkkkggggrrrroooouuuunnnndddd::::

1. From the Import menu, choose Background.

2. Select a BMP, GIF, JPEG, PDF, PICT, PNG, SGI, TGA, or TIFF file format from the Enable 
pop-up menu.

3. Locate and select the picture you want to import.

4. Choose one of these options:

• Shrink/stretch to fill canvas stretches or shrinks the picture to fill the whole drawing area. 

• Fill canvas without shrinking/stretching puts the picture on the canvas so that it fills as 
much of the drawing area as possible without shrinking or stretching the picture out of 
shape. The edges of the drawing area might be left white.

• Center at original size puts the picture down the way it is, without stretching or shrinking 
it.

• Repeat many times scales the picture down to 25% of its original size and puts down lots 
of these smaller versions until the drawing area is filled.

5. To add your background to the My Backgrounds category, click the checkbox labeled “Add to 
My Backgrounds library when importing” so that a checkmark appears. 

6. Click Import to import the picture as your new background. 

Note: If you choose to add a picture to the My Backgrounds category while importing, and 
the Backgrounds Library was open before you performed the import, the My Backgrounds 
category will automatically be chosen in the pop-up menu and the imported background will be 
selected in the tray.

TTTToooo    rrrreeeemmmmoooovvvveeee    aaaa    bbbbaaaacccckkkkggggrrrroooouuuunnnndddd    ffffrrrroooommmm    tttthhhheeee    MMMMyyyy    BBBBaaaacccckkkkggggrrrroooouuuunnnnddddssss    ccccaaaatttteeeeggggoooorrrryyyy::::
1. Choose the My Backgrounds category from the List of Categories pop-up menu.

2. Select the background you want to delete.

3. Click the Trash Can button.
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SSSSttttiiiicccckkkkeeeerrrrssss    LLLLiiiibbbbrrrraaaarrrryyyy
Stickers are pictures you “stick” onto your picture. Stickers do not become a part of the background 
unless you flatten them.

TTTToooo    aaaadddddddd    aaaa    ssssttttiiiicccckkkkeeeerrrr::::
1. Click the Stickers Library button to open the Stickers tray. All stickers are divided 

into two collections: objects and flags.

2. Select a collection.

3. Choose a category from the List of Categories pop-up menu.

4. Scroll through the stickers.

5. Add a sticker to your picture.

TTTToooo    mmmmoooovvvveeee,,,,     cccchhhhaaaannnnggggeeee,,,,     oooorrrr    ddddeeeelllleeeetttteeee    aaaa    ssssttttiiiicccckkkkeeeerrrr::::

1. Click a sticker in your picture to select it.

2. Do any of these things:

• To move the sticker, simply drag it to the place you want. Alternatively, you can move 
stickers by pressing Shift+arrow key or Option+Shift+arrow key on your keyboard.

• To resize the sticker, drag one of the Scale handles. To resize it proportionally, press the 
Shift key while dragging.

Object Stickers Flag Stickers

List of Categories Scrolling 
arrows

Sticker 
Preview

Sticker Name

Scale

Flip Vertically

Scale

Flip Horizontally

ScaleScale
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• To flip the sticker vertically, click the left button located at the bottom center.

• To flip the sticker horizontally, click the right button located at the bottom center.

• To make a sticker part of the background, open the Paint Zone menu and choose Flatten 
Stickers & Animations. You can choose to flatten only the selected sticker or all stickers 
and animations.

• To delete a sticker, press the Delete key on your keyboard. When you delete a sticker, you 
will see it disappears in a puff of smoke, like magic.
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AAAAnnnniiiimmmmaaaattttiiiioooonnnnssss    LLLLiiiibbbbrrrraaaarrrryyyy
Animations come to life when you play them.

TTTToooo    aaaadddddddd    aaaannnn    aaaannnniiiimmmmaaaattttiiiioooonnnn::::

1. Click the Animations Library button to open the Animations tray.

2. Choose a category from the List of Categories pop-up menu.

3. Scroll through the animations.

4. Add an animation to your picture. The animation plays automatically when you add 
it to the canvas. You can play all the animations in a picture by clicking the Play 
button located at the top-right corner of the screen.

TTTToooo    mmmmoooovvvveeee,,,,     cccchhhhaaaannnnggggeeee,,,,     oooorrrr    ddddeeeelllleeeetttteeee    aaaannnn    aaaannnniiiimmmmaaaattttiiiioooonnnn::::

1. Click an animation in your picture to select it.

List of Categories Scrolling 
Arrows

Animation 
Preview
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2. Do any of these things:

• To move the animation, drag it to the place you want. Alternatively, you can move 
animations by pressing Shift+arrow key or Option+Shift+arrow key on your keyboard.

• To resize the animation, drag one of the Scale handles. To resize it proportionally, press the 
Shift key while dragging.

• To flip an animation vertically and/or horizontally, click the Flip Vertically or Flip Horizontally 
buttons.

• To make an animation part of the background, choose Flatten Stickers & Animations 
from the Paint Zone menu. You can choose to flatten only the selected animation or all 
animations and stickers.

• To delete an animation, press the Delete key on your keyboard. When you delete an 
animation, you will see it disappears in a puff of smoke, like magic.

PPPPllllaaaayyyyiiiinnnngggg    AAAAnnnniiiimmmmaaaattttiiiioooonnnnssss

You can play animations in a loop or frame-by-frame.

TTTToooo    ppppllllaaaayyyy    aaaannnn    aaaannnniiiimmmmaaaattttiiiioooonnnn    iiiinnnn    aaaa    lllloooooooopppp::::

1. Click the animation to select it.

2. Click the Play button. It changes to the Pause button.

3. To pause the animation, click the Pause button. It changes back to the Play button.

4. To stop the animation, click the Stop button. The animation returns to its first frame.

TTTToooo    ppppllllaaaayyyy    aaaannnn    aaaannnniiiimmmmaaaattttiiiioooonnnn    ffffrrrraaaammmmeeee----bbbbyyyy----ffffrrrraaaammmmeeee::::

1. Click an animation to select it.

2. Click the One Frame Forward button. Each click advances the animation one frame 
forward.

3. Click the One Frame Backward button. Each click advances the animation one frame 
back.

AAAAnnnniiiimmmmaaaattttiiiioooonnnn    TTTTiiiippppssss

• When you print your picture, the animation frame you see is the one that is printed. You can play 
the animation frame-by-frame and stop it when it looks how you want it to be printed.
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SSSSoooouuuunnnnddddssss    LLLLiiiibbbbrrrraaaarrrryyyy
You can add a sound from the Kid Pix Sounds Library, import one, or record your own. When you record 
or import a sound, it can be added to the My Sounds category.

TTTToooo    aaaadddddddd    aaaa    ssssoooouuuunnnndddd    ffffrrrroooommmm    tttthhhheeee    llll iiiibbbbrrrraaaarrrryyyy::::

1. Click the Sounds Library button to see the Sounds tray.

2. Choose a category from the List of Categories pop-up menu.

3. Scroll through the sounds.

4. Click a sound to hear how it sounds. The sound keeps playing until you click somewhere 
else on the screen.

5. Add the sound you want to your picture. The sound plays automatically when you add it to 
the canvas. You can also hear the added sound when you click the Play button located at 
the top-right corner of the screen.

TTTToooo    rrrreeeemmmmoooovvvveeee    tttthhhheeee    ssssoooouuuunnnndddd    ffffrrrroooommmm    yyyyoooouuuurrrr    ppppiiiiccccttttuuuurrrreeee::::
1. Click the No Sound button in the Sounds tray.

TTTToooo    rrrreeeeccccoooorrrrdddd    aaaa    ssssoooouuuunnnndddd::::

1. Click the Sounds Library button to see the Sounds tray

2. In the Sounds tray, click the Open Sound Recording Tray button. The button changes 
to the Close Sound Recording Tray button, which you can click to return to the Sounds 
tray.

3. In the Sound Recording tray, click the Record button to start recording.

4. Click the Stop button to stop recording.

5. Click the Play button to hear the recorded sound.

List of Categories

Sound PreviewOpen Sound Recording Tray

Import From iTunesNo Sound

Trash Can

Sound Name

Record Play Close Sound Recording Tray

Stop Save

Recording Time 
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6. Click the Save button to save the recorded sound.

7. Give your sound a name so you can find it again in the My Sounds category and click OK.

The Sound Recording Tray automatically closes and the My Sounds category opens for you 
to add your new sound to the picture.

TTTToooo    iiiimmmmppppoooorrrrtttt     aaaa    ssssoooouuuunnnndddd::::

1. Choose Sound from the Import menu. Alternatively, you can import sound using the Kid Pix: 
Import From iTunes dialog. For more information on importing directly from iTunes, see 
"Importing Sounds from iTunes" on page 43.

2. Find the sound file you want to import and click it. 

With Kid Pix Deluxe 3X, you can now import the following sound formats: AIFF, WAV, MP3, 
CDDA, AU, SND, and AAC.

Note: If you are using a version of Mac OS earlier than Mac OS 10.3, you need to have 
QuickTime 6.5 installed to be able to work with the AAC format.

3. To add your sound to the My Sounds category, click the checkbox labeled “Add to My Sounds 
library when importing” so that a checkmark appears. 

4. Click Import to add the sound to the picture. 

Note: If you choose to add the sound to the My Sounds category when importing, and the 
Sounds Library was open before you performed the import, the My Sounds category will 
automatically be chosen in the pop-up menu and the imported sound will be selected in the tray.

TTTToooo    rrrreeeemmmmoooovvvveeee    aaaa    ssssoooouuuunnnndddd    ffffrrrroooommmm    tttthhhheeee    MMMMyyyy    SSSSoooouuuunnnnddddssss    ccccaaaatttteeeeggggoooorrrryyyy::::
1. Choose the My Sounds category from the List of Categories pop-up menu.

2. Select the sound you want to delete.

3. Click the Trash Can button.
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AAAAddddddddiiiinnnngggg    SSSSttttuuuuffffffff     ttttoooo    YYYYoooouuuurrrr    PPPPiiiiccccttttuuuurrrreeee
In this chapter you will learn about:

• Adding Pictures

• Adding Sounds

• Adding Movies

AAAAddddddddiiiinnnngggg    PPPPiiiiccccttttuuuurrrreeeessss
Photographs and pictures you create with other programs can become a part of your Kid Pix picture. 
You can even paint on them and add special effects.

TTTToooo    aaaadddddddd    aaaa    ppppiiiiccccttttuuuurrrreeee::::

1. From the Import menu, choose Graphic.

2. Find the picture you want to add and click it. Choose BMP, GIF, JPEG, PDF, PICT, PNG, SGI, 
TGA, or TIFF format from the Enable pop-up menu.

3. Select one of these options:

• Shrink/stretch to fill canvas stretches or shrinks the picture to fill the whole drawing area. 

• Fill canvas without shrinking/stretching puts the picture on the canvas so that it fills as 
much of the drawing area as possible without shrinking or stretching the picture out of 
shape. The edges of the drawing area might be left unfilled.

• Center at original size puts the picture down as it is, without stretching or shrinking it.

• Repeat many times scales the picture down to 25% of its original size and puts down lots 
of these smaller versions until the drawing area is filled.

4. Click Import to add the graphic to the picture.

5. You can use the handles of the graphic to change its size.

Note: If you click anywhere outside of the imported picture, the picture will automatically be 
flattened.

PPPPiiiiccccttttuuuurrrreeee    TTTTiiiippppssss

• To add a graphic to the picture as a background, see "Importing Backgrounds" on page 32.
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AAAAddddddddiiiinnnngggg    SSSSoooouuuunnnnddddssss

TTTToooo    iiiimmmmppppoooorrrrtttt     aaaa    ssssoooouuuunnnndddd::::

1. From the Import menu, choose Sound.

2. Find the sound file you want to import and click it.

With Kid Pix Deluxe 3X you can now import the following sound formats: AIFF, WAV, MP3, 
CDDA, AU, SND, and AAC.
Note: If you are using a version of Mac OS earlier than Mac OS 10.3, you need to have 
QuickTime 6.5 installed to be able to work with the AAC format.

3. To add your sound to the My Sounds category, click the checkbox labeled “Add to My Sounds 
library when importing” so that a checkmark appears. For information on using the Sounds 
Library, see "Sounds Library" on page 37.

4. Click Import to add the sound to your picture. 

AAAAddddddddiiiinnnngggg    MMMMoooovvvviiiieeeessss
You can add QuickTime or MPEG movies to a Kid Pix picture.

TTTToooo    aaaadddddddd    aaaa    mmmmoooovvvviiiieeee::::

1. From the Import menu, choose Movie.

2. Find the movie you want to import and click it. 

3. Click Import to add the movie.

TTTToooo    mmmmoooovvvveeee,,,,     cccchhhhaaaannnnggggeeee,,,,     oooorrrr    ddddeeeelllleeeetttteeee    aaaa    mmmmoooovvvviiiieeee::::

1. Click the Grab Tools button. The Grab tray appears.

2. Click Grab Hand.

3. Do any of these things:

• To move a movie, select it and drag it to where you want it to be. Alternatively, you can 
move a movie by pressing Shift+any arrow key or Option+Shift+any arrow key on your 
keyboard.

• To resize a movie, select it and drag one of the Scale handles on its frame. To resize it 
proportionally, press the Shift key while dragging.

• To make a movie part of the background, select it and then choose Flatten Movies from 
the Paint Zone menu. You can choose to flatten only the selected movie or all movies.

• To delete a movie, select it and press the Delete key on your keyboard.
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PPPPllllaaaayyyyiiiinnnngggg    MMMMoooovvvviiiieeeessss

You can play movies in a loop or frame-by-frame. Movies are also played when you play your whole 
picture.

TTTToooo    ppppllllaaaayyyy    aaaa    mmmmoooovvvviiiieeee    iiiinnnn    aaaa    lllloooooooopppp::::

1. Click the movie to select it.

2. Click the Play button. It changes to the Pause button.

3. To pause the movie, click the Pause button. It changes back to the Play button.

4. To stop the movie, click the Stop button. The movie returns to its first frame.

TTTToooo    ppppllllaaaayyyy    aaaa    mmmmoooovvvviiiieeee    ffffrrrraaaammmmeeee----bbbbyyyy----ffffrrrraaaammmmeeee::::

1. Click the movie to select it.

2. Click the One Frame Forward button. Each click advances the movie one frame forward.

3. Click the One Frame Backward button. Each click advances the movie one frame back.

MMMMoooovvvviiiieeee    TTTTiiiippppssss
• If you do not have your own movies, you can use the ones stored in the QuickTime Movies 

folder. It is located in the Users/Shared/Kid Pix Deluxe 3X folder on your system disk.

• To export Kid Pix pictures as QuickTime movies, see "Exporting a Picture" on page 50. To export 
Slide Shows as QuickTime movies, see "Exporting Your Slide Show" on page 58. To export Kid Pix 
documents as iMovie projects, see "To export a picture to iMovie" on page 50 and "To export a 
Slide Show to iMovie" on page 59.

• When you print your picture, the movie frame you see is the one that will be printed. You can play 
the movie frame-by-frame and stop it when it looks the way you want it to be printed.
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IIIInnnntttteeeeggggrrrraaaattttiiiioooonnnn    wwwwiiiitttthhhh    iiiiAAAAppppppppssss
Now you can import your pictures directly from iPhoto albums, add your favorite tracks directly from 
iTunes playlists, and bring more fun to iMovie projects with Kid Pix drawings and animations.

In this chapter you will learn about:

• Importing Pictures from iPhoto

• Importing Sounds from iTunes

• Working with iMovie Projects

IIIImmmmppppoooorrrrttttiiiinnnngggg    PPPPiiiiccccttttuuuurrrreeeessss    ffffrrrroooommmm    iiiiPPPPhhhhoooottttoooo
You can browse through your iPhoto digital albums directly from Kid Pix. Photographs you store in your 
iPhoto library can become a part of your Kid Pix picture. 

TTTToooo    iiiimmmmppppoooorrrrtttt     aaaa    ppppiiiiccccttttuuuurrrreeee    ffffoooollll lllloooowwww    tttthhhheeeesssseeee    sssstttteeeeppppssss::::

1. From the Import menu, choose From iPhoto.

2. The Kid Pix: Import From iPhoto dialog appears.
Note: If you have moved, renamed, or deleted the iPhoto library that was stored in the default 
location (the folder /Users/username/Pictures/iPhoto Library), you cannot import any 
photos from your iPhoto library unless you restore it to this location.

3. Choose one of your iPhoto albums and select the photograph you want to import.

Drag this 
slider to zoom 
your photos
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4. Select one of the Import As radio buttons:

• Click Image if you want to be able to move and resize the photograph after importing.

• Click Background to import the image as a background. To add your photograph to the My 
Backgrounds category, click the checkbox labeled “Add to My Backgrounds library 
when importing” so that a checkmark appears. Once imported, this image can then be 
accessed in the My Backgrounds category. For information on using the Backgrounds 
Library, see "Backgrounds Library" on page 31.

5. Select one of these options:

• Shrink/stretch to fill canvas stretches and/or shrinks the photograph to fill the whole 
drawing area.

• Fill canvas without shrinking/stretching puts the photograph on the canvas so that it 
fills as much of the drawing area as possible without shrinking or stretching the 
photograph out of shape. The edges of the drawing area might be left unfilled.

• Center at original size puts the photograph down the way it is, without stretching or 
shrinking it.

• Repeat many times scales the photograph down to 25% of its original size and puts down 
lots of these smaller versions until the drawing area is filled.

6. Click Import to import the photograph. The imported photograph will be added to the currently 
open Kid Pix picture.

Note: If you have a version of iPhoto earlier than 2.0 installed on your computer, you can only 
open your custom albums.

IIIImmmmppppoooorrrrttttiiiinnnngggg    SSSSoooouuuunnnnddddssss    ffffrrrroooommmm    iiiiTTTTuuuunnnneeeessss
You can browse through your iTunes playlists directly from Kid Pix and attach your favorite sounds to 
your picture.

TTTToooo    iiiimmmmppppoooorrrrtttt     ssssoooouuuunnnnddddssss    ffffrrrroooommmm    iiiiTTTTuuuunnnneeeessss::::

1. From the Import menu, choose From iTunes.

2. The Kid Pix: Import From iTunes dialog appears. You can sort your songs by artist, album, 
song name, and time.

Note: If you have moved, renamed, or deleted the iTunes library file that was stored in the 
default location (the folder /Users/username/Music/iTunes), you cannot import any sounds 
from your iTunes playlists unless you restore the library file to this location.
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Note: You cannot import audio tracks directly from an audio CD. You should first import them to 
iTunes.

3. To listen to the track you have selected before importing it, click the Test button. To listen to 
it playing in a loop, click the “Loop music” checkbox so that a checkmark appears.

4. Select one of the radio buttons in the Import group. Click the first option to import the 
entire song. Click the second option to import just a fragment, the duration of which can be 
chosen from the pop-up menu. The preset duration of an imported fragment is 5 seconds.

5. If you have chosen to import just a fragment of a song, you can select the checkbox labeled 
“Fade out at the end of selection”. This means the fragment you import will not end abruptly, 
but fade out gradually when it is played.

6. To add your song or song fragment to the My Sounds category, click to select the checkbox 
labeled “Add to My Sounds library when importing”. Once imported, this song can be 
accessed in the My Sounds category. For information on using the Sounds Library, see 
"Sounds Library" on page 37.

7. To import your song or song fragment, click the Import button. The imported song or song 
fragment is added to the currently open Kid Pix picture.

8. Click the Play button to hear the sound you have imported.
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WWWWoooorrrrkkkkiiiinnnngggg    wwwwiiiitttthhhh    iiiiMMMMoooovvvviiiieeee    PPPPrrrroooojjjjeeeeccccttttssss
You can bring more fun to your existing iMovie projects with Kid Pix drawings and animations! Start off 
enhancing your iMovie project by selecting a movie frame you would like to make vivid and playful.

TTTToooo    sssseeeelllleeeecccctttt     aaaannnndddd    ssssaaaavvvveeee    aaaa    ffffrrrraaaammmmeeee    ffffrrrroooommmm    aaaannnn    iiiiMMMMoooovvvviiiieeee    pppprrrroooojjjjeeeecccctttt ::::
1. Launch the iMovie application.

2. Open a project by choosing Open Project from the File menu.

3. Drag the clip you want from the Clips pane to the clip viewer located at the bottom of the screen.

4. With the playhead, select the frame you want to enhance using Kid Pix.

5. Choose Split Video Clip at Playhead, from the Edit menu.

6. Choose Save Frame As from the File menu.

7. In the dialog that appears, select the location where you want to save the frame and type in a 
name for it.

8. Click Save.

TTTToooo    iiiimmmmppppoooorrrrtttt     tttthhhhiiiissss    ffffrrrraaaammmmeeee    ttttoooo    KKKKiiiidddd    PPPPiiiixxxx::::
1. Switch to Kid Pix.

2. Choose Background from the Import menu.

3. In the dialog that appears, locate the frame you have just saved in the iMovie application.

4. Select the “Shrink/stretch to fill canvas” option and click Import. The frame appears in the 
drawing area.

5. Draw, paint, and add anything you wish! Just use your creativity and imagination!

TTTToooo    ppppuuuutttt     tttthhhheeee    ffffrrrraaaammmmeeee    bbbbaaaacccckkkk    iiiinnnnttttoooo    tttthhhheeee    mmmmoooovvvviiiieeee::::

1. In Kid Pix, choose Export to iMovie from the File menu. The Kid Pix: Export to iMovie dialog 
appears.
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2. Type a name for the frame and select the location you want to export the frame to.

3. Click the “Save to folder” radio button to save the frame to the selected location.

Note: If you select the radio button labeled “Open new iMovie project with this clip 
inserted”, you will create a new iMovie project containing only the picture you are exporting. 
This new project will automatically be opened in iMovie.

4. Click the “NTSC” or “PAL” radio button to select the desired video standard.

5. Click Export.

Note: Exporting a movie project may take a long time and the final document may occupy a lot 
of space on your hard disk.

6. Switch back to the iMovie application.

7. Choose Import from the File menu.

8. In the dialog that appears, navigate to the location you specified in the Kid Pix: Export to 
iMovie dialog and select the frame you have exported.

Note: When exporting to iMovie, Kid Pix creates a new iMovie project folder with the name you 
have specified. The frame you have exported from Kid Pix is stored within the Media folder of 
that project.

9. Click Open. The frame appears selected in the Clips pane.

10. Drag your frame from the Clips pane to the place in the clip viewer where you have split the 
original movie.

TTTToooo    ppppllllaaaayyyy    tttthhhheeee    wwwwhhhhoooolllleeee    mmmmoooovvvviiiieeee::::

1. In the clip viewer, click any part of your movie.

2. Choose Select All from the Edit menu.

3. Click the Play button.

Your movie now appears to have a “freeze frame” in which the movie freezes while animations play and 
then the movie continues playing.
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WWWWoooorrrrkkkkiiiinnnngggg    wwwwiiiitttthhhh    PPPPiiiiccccttttuuuurrrreeeessss
In this chapter you will learn about:

• Starting a New Picture

• Saving a Picture

• Opening a Picture

• Playing Your Picture

• Printing Your Picture

• Exporting a Picture

SSSSttttaaaarrrrttttiiiinnnngggg    aaaa    NNNNeeeewwww    PPPPiiiiccccttttuuuurrrreeee
You can start with a blank page or use the Idea Machine like an electronic coloring book.

TTTToooo    ssssttttaaaarrrrtttt     wwwwiiiitttthhhh    aaaa    bbbbllllaaaannnnkkkk    ppppaaaaggggeeee::::

1. Click the Create New Picture button. 

Note: If you have not saved changes made to the picture that is already open, Kid Pix 
asks if you want to save them before creating a new one.

TTTToooo    uuuusssseeee    tttthhhheeee    IIIIddddeeeeaaaa    MMMMaaaacccchhhhiiiinnnneeee::::

1. From the File menu, choose Idea Machine.

Note: If you have not saved changes made to the picture that is already open, Kid Pix asks if you 
want to save them before opening an Idea Machine picture.

2. In the Kid Pix: Idea Machine dialog that appears, select the picture template you want to use.

3. Click Open. 

SSSSaaaavvvviiiinnnngggg    aaaa    PPPPiiiiccccttttuuuurrrreeee
By default, Kid Pix saves your pictures in the My Pictures folder so they are easy to find and open 
again. The My Pictures folder is located in the current Kid Pix user folder that is stored in the Kid Pix 
Users folder within the Documents folder of the current system user.

TTTToooo    ssssaaaavvvveeee    aaaa    nnnneeeewwww    ppppiiiiccccttttuuuurrrreeee::::

1. Click the Save button. The Kid Pix: Save As dialog appears.

2. Type a name and select a location for your picture.

3. Click Save.

Note: If you already have a picture with the same name, Kid Pix asks whether you want 
to replace the old picture with the new one.
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TTTToooo    ssssaaaavvvveeee    cccchhhhaaaannnnggggeeeessss    ttttoooo    aaaa    ppppiiiiccccttttuuuurrrreeee::::
1. Click the Save button.

Note: If you want to leave the original picture without changes, choose the Save As command 
from the File menu and save the picture with the changes you have made as a new picture.

SSSSaaaavvvviiiinnnngggg    aaaa    PPPPiiiiccccttttuuuurrrreeee    aaaassss    aaaa    TTTTeeeemmmmppppllllaaaatttteeee
You can save your picture as a template so that it remains unchanged and you can create several 
versions of your picture based on the template. You can also add your template to the Idea Machine. 
This way you can easily access your template pictures by choosing Idea Machine from the File menu.

TTTToooo    ssssaaaavvvveeee    aaaa    ppppiiiiccccttttuuuurrrreeee    aaaassss    tttteeeemmmmppppllllaaaatttteeee::::

1. Choose Save as Template from the File menu.

2. Type a name and select a location for your picture.

3. If you want to add your picture to the Idea Machine, select the “Also add to the Idea Machine” 
checkbox.

4. Click Save.

Note: If you already have a template with the same name, Kid Pix asks whether you want to replace 
the old template with the new one.

OOOOppppeeeennnniiiinnnngggg    aaaa    PPPPiiiiccccttttuuuurrrreeee
You can open any picture you have created and saved.

TTTToooo    ooooppppeeeennnn    aaaa    ppppiiiiccccttttuuuurrrreeee    yyyyoooouuuu    ssssaaaavvvveeeedddd    eeeeaaaarrrrllll iiiieeeerrrr::::

1. Open the File menu.

2. Choose Open.

Note: If you have not saved changes made to the picture that is already open, Kid Pix asks if you 
want to save them before opening a new picture.

3. In the Kid Pix: Open dialog that appears next, click the picture you want to open.

4. Click Open.

PPPPllllaaaayyyyiiiinnnngggg    YYYYoooouuuurrrr    PPPPiiiiccccttttuuuurrrreeee
If your picture contains animations, movies, or sounds, you can see them play over and over when you 
play your picture.

TTTToooo    ppppllllaaaayyyy    yyyyoooouuuurrrr    ppppiiiiccccttttuuuurrrreeee::::

1. Click the Play button.

It changes to the Stop button.
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2. Click the Stop button to stop playing the picture.

It changes back to the Play button.

PPPPrrrriiiinnnnttttiiiinnnngggg    YYYYoooouuuurrrr    PPPPiiiiccccttttuuuurrrreeee
You can print a Kid Pix picture in a regular size or as a poster. 

Kid Pix prints the frames of movies and animations that are shown at the moment that you print. 

Note: Kid Pix does not print in Small Kids Mode. To be able to print, turn Small Kids Mode off by 
choosing the Turn Small Kids Mode Off command from the Kid Pix application menu.

TTTToooo    pppprrrriiiinnnntttt     yyyyoooouuuurrrr    ppppiiiiccccttttuuuurrrreeee::::

1. Click the Print button. The Print dialog appears.

2. Select one or both of these options:

• Fit to page scales the picture to fit the paper size.

• Reverse print makes a mirror image of a picture you want to print. This option is especially 
useful if you want to create a transfer to be placed on a T-shirt or any other surface.

3. Select one of the following options:

• Full page prints a picture on one separate page.

• Poster 2x2 pages prints your picture on four sheets of paper. 

• Poster 3x3 pages prints your picture on nine sheets of paper.

When you print your picture as a poster, Kid Pix prints parts of it on separate sheets of paper. 
You can then tape the sheets of paper together to make the poster.

4. Click Print to print the picture.
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EEEExxxxppppoooorrrrttttiiiinnnngggg    aaaa    PPPPiiiiccccttttuuuurrrreeee
You can export your Kid Pix picture to another file format to open it without Kid Pix. For example, if you 
save your Kid Pix picture in JPEG format, you can add it to a web page. Kid Pix Deluxe 3X can now 
export in the following graphic formats: BMP, JPEG, PDF, PICT, and TIFF. To retain animation, 
movies, or sounds in your picture, export it as a Flash or QuickTime movie.

The Text-to-Speech functionality is lost when the picture is exported.

TTTToooo    eeeexxxxppppoooorrrrtttt     aaaa    ppppiiiiccccttttuuuurrrreeee::::

1. Open the File menu.

2. Choose Export.

3. Navigate to where you want to save your exported picture.

4. Type a name for the exported picture.

5. Choose an export format from the Format pop-up menu located at the bottom of the dialog:

• BMP, JPEG, PDF, PICT, or TIFF: Everything in the picture is flattened. If you plan to attach 
your picture to an email message, use the JPEG format to get a smaller picture size.

• Macromedia Flash Movie: Your animations and sounds can be played. Flash format requires 
a Flash player. You can download the player by going to www.macromedia.com.

Note: If you export a picture with a movie attached as a Macromedia Flash movie or a 
Standalone Page file, only the current frame of the movie will be shown in the resulting 
document.

• QuickTime Movie: The exported file can be played on any kind of computer with QuickTime 
player installed. To download the player, go to www.apple.com.

• Standalone Page For Mac OS 9/Standalone Page For MS Windows: To export your 
picture as an executable file, choose one of these items, depending on the platform you want 
it to be played or viewed on. This should mean that the exported file contains everything 
necessary for it to be opened and played, and does not require any specific player.

6. Click Export.
To export a picture to iMovie

TTTToooo    eeeexxxxppppoooorrrrtttt     aaaa    ppppiiiiccccttttuuuurrrreeee    ttttoooo    iiiiMMMMoooovvvviiiieeee::::

1. Open the File menu.
2. Choose Export to iMovie. The Kid Pix: Export to iMovie dialog appears.

3. Click the NTSC or PAL radio button to select the video standard for the picture.

4. Navigate to where you want to export your picture.

5. Type in a name for the picture you want to export.

6. Click the radio button labeled “Open new iMovie project with this clip inserted” to add this 
picture to the Clips pane of your new iMovie project, which will be opened right after exporting. 
Alternatively, click the “Save to folder” radio button to export the picture to a folder in a 
selected location so that you can insert it in any iMovie project you want.

7. Click Export.
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WWWWoooorrrrkkkkiiiinnnngggg    wwwwiiiitttthhhh    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
In this chapter you will learn about:

• Creating and Opening Slide Shows

• Loading Pictures

• Editing Pictures

• Moving Pictures Around

• Customizing Your Slide Show

• Playing Your Slide Show

• Printing Your Slide Show

• Saving Your Slide Show

• Exporting Your Slide Show

• Creating Animations from Your Slide Show

CCCCrrrreeeeaaaattttiiiinnnngggg    aaaannnndddd    OOOOppppeeeennnniiiinnnngggg    SSSSllll iiiiddddeeee    SSSShhhhoooowwwwssss
You can make a Slide Show with your pictures. Load pictures into your Slide Show and put them in any 
order you like. Add transition, audio, and page advance options. Then save, play, print, or export your 
Slide Show.

GGGGooooiiiinnnngggg    ttttoooo    SSSSllll iiiiddddeeee    SSSShhhhoooowwww

You can go back and forth between the Paint Zone and Slide Show.

TTTToooo    ggggoooo    ttttoooo    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

• Click the Go to Slide Show button in the bottom-right corner of the Paint Zone, or 
choose Go to Slide Show from the Go menu.

SSSSttttaaaarrrrttttiiiinnnngggg    aaaa    SSSSllll iiiiddddeeee    SSSShhhhoooowwww

You can create a brand new Slide Show or open an existing one.

TTTToooo    ccccrrrreeeeaaaatttteeee    aaaa    nnnneeeewwww    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. Click the Create New Slide Show button at the bottom-left corner of the screen.

2. Load pictures into the slides. For details, see "Loading Pictures" on page 52.

3. Click the Save Slide Show button and type a name for your Slide Show in the Kid Pix: 
Save As dialog.

The name of your Slide Show appears at the top of the screen and a saved Slide Show 
icon appears in the Saved Slide Shows tray.
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TTTToooo    ooooppppeeeennnn    aaaa    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

• Click the icon for the Slide Show you want in the Saved Slide Shows tray at the bottom of the 
screen. 

The Saved Slide Shows tray shows only those Slide Shows which were saved by the current Kid Pix 
user. To open other Slide Shows, choose Open from the File menu.

LLLLooooaaaaddddiiiinnnngggg    PPPPiiiiccccttttuuuurrrreeeessss
Each slide in the Slide Show can contain a Kid Pix picture. 

Once you load the pictures, you can move them into any order you like. If you leave blank slides, 
Kid Pix will skip them when you play your Slide Show. 

TTTToooo    llllooooaaaadddd    aaaa    ppppiiiiccccttttuuuurrrreeee::::

1. Click the desired slide to see the Load Picture icon below it.

2. Click the Load Picture icon. 

3. In the Kid Pix: Load Picture dialog that appears, navigate to the place where your 
pictures are stored and select the one you want (by default they are stored in the My 
Pictures folder).

4. Click Load. 

Perform this operation with as many slides as you need.

EEEEddddiiiitttt iiiinnnngggg    PPPPiiiiccccttttuuuurrrreeeessss
To change a picture you want to load, or to create a new picture, go back to the Paint Zone.

TTTToooo    ggggoooo    bbbbaaaacccckkkk    ttttoooo    tttthhhheeee    PPPPaaaaiiiinnnntttt     ZZZZoooonnnneeee::::

• Click the Go to Paint Zone button in the bottom-right corner of the screen, or choose 
Go to Paint Zone from the Go menu.

MMMMoooovvvviiiinnnngggg    PPPPiiiiccccttttuuuurrrreeeessss    AAAArrrroooouuuunnnndddd
Slide Show plays slides in the order they appear on the screen. (The slides are numbered so you can 
tell the order.) You can move slides into any order you want.

TTTToooo    mmmmoooovvvveeee    aaaa    ssssllll iiiiddddeeee    bbbbyyyy    ddddrrrraaaaggggggggiiiinnnngggg::::

• Drag the slide you want to move to the new location. 
When you drag a slide, you see an insertion line that shows exactly where the picture will be 
placed.
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TTTToooo    mmmmoooovvvveeee    aaaa    ssssllll iiiiddddeeee    bbbbyyyy    ppppaaaassssttttiiiinnnngggg::::

1. Click the slide you want to move.
2. Open the Edit menu and choose Cut or Copy.

• Cut removes a picture from the slide and puts it on the Clipboard so you can paste it 
somewhere else.

• Copy keeps a picture where it is and puts a copy of it on the Clipboard so you can paste it 
somewhere else. 

3. Click a new slide that you want to paste the copied or cut picture into.

4. Open the Edit menu and choose Paste. 

If you paste a picture into a slide that already has a picture, the new picture replaces the old one.

TTTToooo    ddddeeeelllleeeetttteeee    aaaa    ssssllll iiiiddddeeee    ffffrrrroooommmm    yyyyoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

• Drag the slide to the Trash Can, or click to select it and press 
Command + Backspace on your keyboard.

SSSSeeeeeeeeiiiinnnngggg    AAAAllll llll     tttthhhheeee    SSSSllll iiiiddddeeeessss
Use the arrows at the top and bottom of the slides area to scroll through your Slide Show.
Use the arrow keys on your keyboard to move between slideholders one step in any direction, or use 
the following keyboard shortcuts:

• Command + Up Arrow to go to the first slideholder

• Command + Down Arrow to go to the last slideholder

• Command + Left Arrow to go to the leftmost slideholder

• Command + Left Arrow to go to the rightmost slideholder

DDDDeeeelllleeeettttiiiinnnngggg    BBBBllllaaaannnnkkkk    SSSSllll iiiiddddeeeessss

You can “clean up” your Slide Show so that the blank slides do not interrupt the ones with pictures.

TTTToooo    ddddeeeelllleeeetttteeee    bbbbllllaaaannnnkkkk    ssssllll iiiiddddeeeessss::::

• Choose Delete Blank Slides from the Slide Show menu.
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CCCCuuuussssttttoooommmmiiiizzzziiiinnnngggg    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can set page advance options and add visual transition and sound effects to give your Slide Show a 
really exciting, unique appearance. For more information about transition effects, see "Transition 
Effects" on page 55. For information on attaching sounds to your Slide Shows, see "Audio Options" on 
page 56.

PPPPaaaaggggeeee    AAAAddddvvvvaaaannnncccceeee    OOOOppppttttiiiioooonnnnssss

Page advance options tell Slide Show when to go from one slide to the next. You can have a different 
page advance option for each slide. You can tell Slide Show to display the next slide after a certain 
number of seconds, or to wait until the text of the slide is read aloud, or until you click with the mouse 
or press a key on the keyboard. If you do not set any page advance option, each slide will be shown for 
the time you have specified in Kid Pix Preferences. For more information, see "Setting Up Kid Pix 
Preferences" on page 61.

TTTToooo    sssseeeetttt     uuuupppp    ppppaaaaggggeeee    aaaaddddvvvvaaaannnncccceeee    ooooppppttttiiiioooonnnnssss::::

1. Click the Customize Slide Show Effects button. The customizing option buttons appear 
on each slide.

2. Click the Page Advance Options button on the slide whose options you want to change. The 
Page Advance dialog appears.

3. Select one of these options:

Transition Effects 
Options

Page Advance Options

Audio Options
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• Timer lets you enter the number of seconds to wait between this slide and the next one. 
Choose this option if you are planning to export your Slide Show later as a movie. See 
"Exporting Your Slide Show" on page 58.

• Mouse Click tells Slide Show to wait until you click with the mouse before the next slide is 
displayed.

• Key Down tells Slide Show to wait until you press any key on your keyboard (except Escape) 
before the next slide is displayed. The Escape key stops the Slide Show.

• Read Text Done tells Slide Show to read text in the picture and then display the next slide.

4. Click OK.

TTTTrrrraaaannnnssssiiiittttiiiioooonnnn    EEEEffffffffeeeeccccttttssss

You can set up special effects between slides. These include Fade, Windmill, Wipe, Iris, and many 
more. Each effect has a sound associated with it. You can change the sound for any effect.

TTTToooo    sssseeeetttt     uuuupppp    ttttrrrraaaannnnssssiiiitttt iiiioooonnnn    eeeeffffffffeeeeccccttttssss::::

1. Click the Customize Slide Show Effects button. The customizing option buttons appear 
on each slide.

2. Click the yellow Transition Effects Options arrow button on the left side of a slide to 
change the transition into that slide. The Select Transition and Sound dialog appears.

3. Select a visual transition effect in the upper scroll list.

Audio Options

Transition Effects 
Options

Page Advance Options

No Sound

No Transition
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If you do not want to have any transition effects, click the No Transition option.

The bottom scroll list shows you the sound effects associated with the visual effect you have 
selected.

4. Leave the sound as it is, select another, or click the No Sound option at the end of the list to 
make the transition silent. 

5. Click PREVIEW to see how the transition looks and sounds.

6. Click OK to apply the selected effects.

AAAAuuuuddddiiiioooo    OOOOppppttttiiiioooonnnnssss

Audio options tell Slide Show to play all the slide’s sounds and text, play either the sound or the text, or 
not to play them at all.

TTTToooo    sssseeeetttt     uuuupppp    aaaauuuuddddiiiioooo    ooooppppttttiiiioooonnnnssss::::

1. Click the Customize Slide Show Effects button. The customizing option buttons appear 
on each slide.

2. Click the Audio Options button for a slide you want to change.

3. Tell Slide Show what to do while this slide is showing:

• Select PLAY SOUND to tell Slide Show to play the sound attached to this picture.

• Select PLAY TEXT to tell Slide Show to read the text of this picture out loud.

• Turn both options off to tell Slide Show not to play the sounds attached to the picture and not 
to read the text out loud.

4. Click OK to apply the changes. 

BBBBaaaacccckkkkggggrrrroooouuuunnnndddd    CCCCoooolllloooorrrr
Slides in a Slide Show appear on a solid color background. You can change this color.

TTTToooo    cccchhhhaaaannnnggggeeee    tttthhhheeee    bbbbaaaacccckkkkggggrrrroooouuuunnnndddd    ccccoooolllloooorrrr    ffffoooorrrr    tttthhhheeee    ccccuuuurrrrrrrreeeennnntttt     SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. From the Slide Show menu, choose Change Background Color.

2. Pick a color and click OK.

PPPPllllaaaayyyyiiiinnnngggg    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can now play your Slide Show to see all your pictures enlivened with the added effects.

Audio Options

Transition Effects 
Options

Page Advance Options
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TTTToooo    ppppllllaaaayyyy    yyyyoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. Click the Play Slide Show button.

2. If your page advance options are set up to wait for a click or keyboard key press, you 
need to click or press a key to advance the slides.

Note: To stop a Slide Show while it is playing, double-click anywhere on the screen or 
press the Escape key on your keyboard.

UUUUssssiiiinnnngggg    MMMMaaaannnnuuuuaaaallll     AAAAddddvvvvaaaannnncccceeee

Manual advance lets you advance the slides manually, while keeping your visual and sound transition 
effects in place.

TTTToooo    uuuusssseeee    mmmmaaaannnnuuuuaaaallll     aaaaddddvvvvaaaannnncccceeee::::

1. From the Slide Show menu, choose Turn Manual Advance On.

2. Play a Slide Show by clicking the Play Slide Show button.

3. Click with the mouse or press any key on your keyboard (except Escape) to advance to 
the next slide.

Note: The Escape key stops the Slide Show.

PPPPrrrriiiinnnnttttiiiinnnngggg    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can print each slide of your Slide Show separately on its own page, or you can print small-sized 
slides on one page. 

TTTToooo    pppprrrriiiinnnntttt     yyyyoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. Click the Print button. The Print dialog appears.

2. Select one of these formats:

• Full page prints each slide on a single separate page. Type the number of the slide you want 
to print in the Starting slide box.
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• Storybook prints two slides on each page.

• Comic book prints six slides on each page, with the slides placed in two rows. To print six 
slides on a page, select Comic book and type 1 in the Starting slide box and 6 in the 
Ending slide box, and then click Print. To print the next six slides, click the Print button 
again and type 7 in the Starting slide box and 12 in the Ending slide box, and so on.

• Card / booklet prints 4 slides per page. Slides are placed in two rows, one of which is 
upside-down. When you have printed the page, you can fold it in four to make a fun greeting 
card. You can also print just one slide on the first panel and then write on the other panels. 
To print four slides on a page, select Card / booklet and type 1 in the Starting slide box 
and 4 in the Ending slide box, and then click Print. To print the next four slides, choose 
Print again and type 5 in the Starting slide box and 8 in the Ending slide box, and so on.

• Thumbnail prints twenty-four slides on each page. To print twenty-four slides on a page, 
select Thumbnail and type 1 in the Starting slide box and 24 in the Ending slide box, and 
then click the Print button again. If your Slide Show is longer than that, click the Print 
button again and type 25 in the Starting slide box and 48 in the Ending slide box, and so 
on.

3. If you select Storybook, Card / booklet or Comic book, you can also choose one of these 
orientations:

• Portrait prints the slides on a vertical page.

• Landscape prints the slides on a horizontal page.

4. Click Print to print the Slide Show.

SSSSaaaavvvviiiinnnngggg    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
Slide Shows are saved in the My Slide Shows folder (inside the My Pictures folder) by default.

TTTToooo    ssssaaaavvvveeee    yyyyoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. Click the Save Slide Show button.

2. Type a name for your Slide Show.

3. Click Save.

EEEExxxxppppoooorrrrttttiiiinnnngggg    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can export your Slide Show to play it with or without Kid Pix. Exported Slide Shows do not include 
the Text-to-Speech feature.

TTTToooo    eeeexxxxppppoooorrrrtttt     yyyyoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww::::

1. Choose Export, from the File menu.

2. Type a name for the exported Slide Show.

3. Navigate to where you want to save your exported Slide Show. 

4. Choose an export format.
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• Project As QuickTime Movie can be played on any computer with or without Kid Pix. 
However, QuickTime format supports only the Timer advance option.

Use QuickTime player to open and play your exported Slide Show.

• Slide Show To Go creates a folder with everything you need to play your Slide Show on a 
different computer with Kid Pix. Copy the folder to another computer then in the Slide Show 
part of Kid Pix, use the Open command from the File menu to open the Slide Show file in 
that computer’s version of Kid Pix. Kid Pix will find all the files it needs to open your Slide 
Show.

5. Click Export.

To export a Slide Show to iMovie

TTTToooo    eeeexxxxppppoooorrrrtttt     aaaa    SSSSllll iiiiddddeeee    SSSShhhhoooowwww    ttttoooo    iiiiMMMMoooovvvviiiieeee::::

1. Open the File menu.

2. Choose Export to iMovie. The Kid Pix: Export to iMovie dialog appears.

3. Click the NTSC or PAL radio button to select the video standard for a Slide Show.

4. Type a name for the Slide Show you want to export.

5. Navigate to where you want to save your Slide Show.

6. Click the radio button labeled “Open new iMovie project with this clip inserted” to create 
and automatically open a new iMovie project with this Slide Show only. Alternatively, click the 
“Save to folder” radio button to save the Slide Show to the selected location.

7. Click Export. 

Note: Exporting a Slide Show may take a long time and the resulting document may occupy a lot 
of disk space.

CCCCrrrreeeeaaaattttiiiinnnngggg    AAAAnnnniiiimmmmaaaattttiiiioooonnnnssss    ffffrrrroooommmm    YYYYoooouuuurrrr    SSSSllll iiiiddddeeee    SSSShhhhoooowwww
You can create simple animations using Slide Show projects you have created.

TTTToooo    sssseeeetttt     ddddeeeeffffaaaauuuulllltttt     aaaannnniiiimmmmaaaattttiiiioooonnnn    ooooppppttttiiiioooonnnnssss::::

1. Choose Kid Pix Preferences from the Kid Pix menu.

2. Open the Slide Show pane in the dialog that appears and choose No Transition from the 
Transition Effect pop-up menu.

Note: When you choose No Transition, the transition sound effect automatically changes to No 
Sound.

3. Set the Timer interval to any value small enough for an animation. For example, to 0.1 second.

4. Click OK.
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TTTToooo    ccccrrrreeeeaaaatttteeee    aaaannnniiiimmmmaaaattttiiiioooonnnn    ffffrrrraaaammmmeeeessss::::

1. Create a picture or open one you have already created. 

2. Add an object or several objects (stickers, text, and so on) that you want to animate. 

3. Save the picture. Now you have the first frame of your animation.

4. Modify the added object or objects slightly (move and resize them, change the color, and so on).

5. Save your work as a different picture by choosing Save As from the File menu. 

Tip: If you add numbers to picture names, it will be easier to see the order for frames in the 
animation.

6. Repeat steps 4-5 to create more frames for your animation.

TTTToooo    ccccrrrreeeeaaaatttteeee    aaaannnn    aaaannnniiiimmmmaaaattttiiiioooonnnn::::

1. Create a new Slide Show.

2. Load the pictures you have created for the animation. See "Loading Pictures" on page 52.

3. Set or modify transition options as described in the "Customizing Your Slide Show" on page 54.

4. Export your Slide Show either to iMovie or to QuickTime to get an animated cartoon. See 
"Exporting Your Slide Show" on page 58.
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OOOOppppttttiiiioooonnnnssss    ffffoooorrrr    PPPPaaaarrrreeeennnnttttssss    aaaannnndddd    EEEEdddduuuuccccaaaattttoooorrrrssss
In this chapter you will learn about:

• Setting Up Kid Pix Preferences

• Administrating the Login Dialog

• Activating Small Kids Mode

• Controlling Sound

SSSSeeeettttttttiiiinnnngggg    UUUUpppp    KKKKiiiidddd    PPPPiiiixxxx    PPPPrrrreeeeffffeeeerrrreeeennnncccceeeessss
Using the Kid Pix Preferences dialog, you can specify different Kid Pix settings for each Kid Pix user.

TTTToooo    sssseeeetttt     uuuupppp    KKKKiiiidddd    PPPPiiiixxxx    PPPPrrrreeeeffffeeeerrrreeeennnncccceeeessss::::

1. Choose Kid Pix Preferences from the Kid Pix application menu. The Kid Pix Preferences 
dialog appears.

2. In the General pane, you can specify the following settings.
• Click the Menu bar hiding on checkbox to have the menu bar automatically hidden when you 

are using Kid Pix Deluxe 3X.
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• If you do not want to see the Kid Pix movie every time you launch the application, select the 
checkbox labeled “Skip the Kid Pix movie on startup”.

• If you don’t want the Login dialog to appear, and you want your home Documents folder set 
as the default location for saving files, select the Skip the Login dialog checkbox.

• For the first text box you create, choose a font from the Font pop-up menu, and a font size 
from the Size pop-up menu.

3. Click the Drawing icon at the top of the dialog to open the Drawing pane and specify the sound 
and Text-to-Speech settings for your drawing tools.
• Click the “Turn tool sounds on” checkbox to turn sound effects on or off when you are using 

the tools and trays in Kid Pix Deluxe 3X.

• Click the checkbox labeled “Play added music or sounds” to turn on or off sounds attached 
to your pictures.

• Select the checkbox labeled “Turn on Read-Aloud Text feature” to hear the text from text 
boxes read aloud.

4. Click the Slide Show icon to open the Slide Show pane and select settings for your Slide 
Shows:
• Select the checkbox labeled “Play sounds during Slide Show” to hear the sounds attached 

to your pictures when you play your Slide Show.

• Select the checkbox labeled “Read aloud text during Slide Show” to hear text from text 
boxes read aloud when you play your Slide Show.

• In the Default Slide Show Settings group, choose default transition and sound effects from 
the corresponding pop-up menus. These effects will play when one slide is advancing to the 
next. From the Timer group, choose a time interval between slides. From the Background 
Color pop-up menu, choose a color to fill the screen behind your slides while your Slide Show 
is playing. These effects will be applied to new Slide Shows you create unless you change them 
manually.

5. Click the Help icon to open the Help pane and specify the following settings.
• Select the checkbox labeled “Provide coaching hints if no activity” to make the coaching 

help active.
• Using the Delay before hints pop-up menu, set the period of time after which the coaching 

help will start if there is no mouse or keyboard activity.
• Select the checkbox labeled “Turn automatic help tags on” to see and hear helpful 

explanations for tools and buttons when you place your pointer over them.
• If you want to hear help tag text read out loud, click the checkbox labeled “Speak automatic 

help tag text after” to turn the automatic help tag speaking feature on. From the pop-up 
menu, choose the time after which the text will be spoken out loud.

• Select the checkbox labeled “Read aloud alert messages” to hear alert messages spoken 
out loud.

6. Click the Updates icon to open the Updates pane and select the following options.
• Click the Automatically radio button to check for updates automatically each time you launch 

Kid Pix when connected to Internet.

• Click the Manually radio button to check for updates only when you click the Check Now 
button.

• Click the Check Now button to start checking for updates right now.
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7. Click OK to apply all the settings you have specified.

AAAAddddmmmmiiiinnnniiiissssttttrrrraaaattttiiiinnnngggg    tttthhhheeee    LLLLooooggggiiiinnnn    DDDDiiiiaaaalllloooogggg
Using the Login dialog, you can create multiple users or log in as a different user.

SSSSeeeettttttttiiiinnnngggg    UUUUpppp    MMMMuuuullllttttiiiipppplllleeee    UUUUsssseeeerrrrssss

For classroom use, or if lots of kids use the same computer, you can set up the application for multiple 
users.

TTTToooo    sssseeeetttt     uuuupppp    mmmmuuuulllltttt iiiipppplllleeee    uuuusssseeeerrrrssss::::

1. In the Log In dialog, type KidPixAdmin and then click GO. For details on opening the Log In 
dialog, see “Logging In as a New Kid Pix User” below.

2. Type the names of new users and click ADD after each one to add them to the list.

3. Click DONE when you have finished.

TTTToooo    ddddeeeelllleeeetttteeee    aaaa    uuuusssseeeerrrr::::

1. In the Log In dialog, type KidPixAdmin and then click GO.

1. Select an user name you want to remove.

2. Click DELETE.

3. Click DONE when you have finished.

LLLLooooggggggggiiiinnnngggg    IIIInnnn    AAAAssss    aaaa    NNNNeeeewwww    KKKKiiiidddd    PPPPiiiixxxx    UUUUsssseeeerrrr

If you have more then one Kid Pix user added, you can log in as any one of them any time you want 
while working with Kid Pix.

TTTToooo    lllloooogggg    iiiinnnn    aaaassss    aaaa    nnnneeeewwww    uuuusssseeeerrrr::::

1. Open the Kid Pix application menu and choose Log In as New Kid Pix User.

2. Select a user name from the list labeled “Select your name here”.

3. Click GO.

TTTTuuuurrrrnnnniiiinnnngggg    OOOOffffffff     tttthhhheeee    LLLLooooggggiiiinnnn    DDDDiiiiaaaalllloooogggg

You can turn off the Login dialog that appears when you launch Kid Pix. 

Once the dialog is turned off, all Kid Pix documents you create will be saved by default to the home 
folder where your documents are stored.

TTTToooo    ttttuuuurrrrnnnn    ooooffffffff     tttthhhheeee    LLLLooooggggiiiinnnn    ddddiiiiaaaalllloooogggg::::

1. Choose Kid Pix Preferences from the Kid Pix menu.

2. Select the Skip the Login dialog option in the General pane of the dialog that appears. 
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AAAAccccttttiiiivvvvaaaattttiiiinnnngggg    SSSSmmmmaaaallll llll     KKKKiiiiddddssss    MMMMooooddddeeee
Kid Pix has two modes: Normal Mode and Small Kids Mode. In Normal Mode, all the Kid Pix tools 
and features are active. In Small Kids Mode, complex features (like most of the menu options, Slide 
Show, and printing) are inactive. This lets younger children create freely, without confusion. 

In Small Kids Mode, children can:

• Use all the art tools.

• Add text to a picture using rubber stamp letters, symbols, and numbers instead of the keyboard. 
When a child clicks a character in the tray, Kid Pix says its name out loud.

TTTToooo    ttttuuuurrrrnnnn    SSSSmmmmaaaallll llll     KKKKiiiiddddssss    MMMMooooddddeeee    oooonnnn    oooorrrr    ooooffffffff::::

1. From the Kid Pix application menu, choose Turn Small Kids Mode On. 

2. To return to Normal Mode, choose Turn Small Kids Mode Off from the Kid Pix application 
menu.

CCCCoooonnnnttttrrrroooollll llll iiiinnnngggg    SSSSoooouuuunnnndddd
Using the Kid Pix Preferences dialog, you can turn on or off tool sounds, attached sounds, and Text-
to-Speech effects for each user. For more information on controlling sound settings, see "Setting Up Kid 
Pix Preferences" on page 61.
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TTTThhhheeee    KKKKiiiidddd    PPPPiiiixxxx    DDDDeeeelllluuuuxxxxeeee    3333XXXX    MMMMeeeennnnuuuussss
In this chapter you will learn about:

• The Kid Pix Application Menu

• The File Menu

• The Edit Menu

• The Import Menu

• The Go Menu

• The Paint Zone Menu

• The Slide Show Menu

• The Help Menu

TTTThhhheeee    KKKKiiiidddd    PPPPiiiixxxx    AAAAppppppppllll iiiiccccaaaattttiiiioooonnnn    MMMMeeeennnnuuuu

AAAAbbbboooouuuutttt     KKKKiiiidddd    PPPPiiiixxxx
Tells you about the current version of the application, its developer team, and credits. 

IIIInnnnssssttttaaaallll llll     KKKKiiiidddd    PPPPiiiixxxx    CCCCDDDD    CCCCoooonnnntttteeeennnnttttssss
Allows you to install all the contents of the application CD on your hard disk. For details, see "Installing 
Kid Pix CD Contents" on page 8.

KKKKiiiidddd    PPPPiiiixxxx    RRRReeeeggggiiiissssttttrrrraaaattttiiiioooonnnn
Opens the Kid Pix Registration page in your default web browser.

PPPPrrrroooovvvviiiiddddeeee    KKKKiiiidddd    PPPPiiiixxxx    FFFFeeeeeeeeddddbbbbaaaacccckkkk
Allows you to share your thoughts about Kid Pix with us. Choose this command to open the Kid Pix 
Feedback page in your default web browser. 

KKKKiiiidddd    PPPPiiiixxxx    PPPPrrrreeeeffffeeeerrrreeeennnncccceeeessss
Allows you to specify different settings of Kid Pix for each user. For details, see "Setting Up Kid Pix 
Preferences" on page 61.

TTTTuuuurrrrnnnn    SSSSmmmmaaaallll llll     KKKKiiiiddddssss    MMMMooooddddeeee    OOOOnnnn////OOOOffffffff
Switches between the modes. For details, see "Activating Small Kids Mode" on page 64.

LLLLoooogggg    IIIInnnn    aaaassss    NNNNeeeewwww    KKKKiiiidddd    PPPPiiiixxxx    UUUUsssseeeerrrr
When you log in as a different user, Kid Pix uses the settings and folder locations specific to this user.
For details, see "Logging In As a New Kid Pix User" on page 63.

SSSSeeeerrrrvvvviiiicccceeeessss
Provides a quick way to perform tasks with several other applications.
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HHHHiiiiddddeeee    KKKKiiiidddd    PPPPiiiixxxx
Hides all the windows of Kid Pix Deluxe 3X.

HHHHiiiiddddeeee    OOOOtttthhhheeeerrrrssss
Hides all applications except Kid Pix Deluxe 3X. This clears the screen of everything but the Kid Pix 
windows. 

SSSShhhhoooowwww    AAAAllll llll
Shows all hidden applications.

QQQQuuuuiiiitttt     KKKKiiiidddd    PPPPiiiixxxx
Quits Kid Pix. You can also click the Quit button on the right side of the Paint Zone to quit.

TTTThhhheeee    FFFFiiii lllleeee    MMMMeeeennnnuuuu

NNNNeeeewwww
Creates a new Kid Pix picture or Slide Show. For details, see "Starting a New Picture" on page 47 and 
"Starting a Slide Show" on page 51.

OOOOppppeeeennnn
Lets you open an existing Kid Pix picture or Slide Show. Kid Pix first looks in the default My Pictures or 
My Slide Shows folders, but you can also browse through other folders on your computer. For details, 
see "Opening a Picture" on page 48 and "Creating and Opening Slide Shows" on page 51.

OOOOppppeeeennnn    RRRReeeecccceeeennnntttt
Lists up to ten recently used Kid Pix pictures or Slide Shows for you to open them easily.

IIIIddddeeeeaaaa    MMMMaaaacccchhhhiiiinnnneeee
Opens the Kid Pix: Idea Machine dialog, where you can select a template picture. You can use the 
Idea Machine like an electronic coloring book. For details, see "Starting a New Picture" on page 47.

SSSSaaaavvvveeee
Saves an open picture or Slide Show. For details, see "Saving a Picture" on page 47 and "Saving Your 
Slide Show" on page 58.

SSSSaaaavvvveeee    AAAAssss
Lets you save an open picture or Slide Show to a selected location with a different name. For details, 
see "Saving a Picture" on page 47 and "Saving Your Slide Show" on page 58.

SSSSaaaavvvveeee    aaaassss    TTTTeeeemmmmppppllllaaaatttteeee
Lets you save an open picture as a template and add it to the Idea Machine. For details, see "Saving a 
Picture as a Template" on page 48.

EEEExxxxppppoooorrrrtttt
Saves your picture or Slide Show in a different format. For details, see "Exporting a Picture" on page 50 
and "Exporting Your Slide Show" on page 58.
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EEEExxxxppppoooorrrrtttt     ttttoooo    iiiiMMMMoooovvvviiiieeee
Exports your picture or Slide Show to iMovie. For details, see "To export a picture to iMovie" on page 50 
and "To export a Slide Show to iMovie" on page 59.

PPPPaaaaggggeeee    SSSSeeeettttuuuupppp
Opens the system Page Setup dialog where you can specify printing settings.

Note: Notwithstanding the Scale value set in the Page Setup dialog, the picture will always be 
printed to fit the selected page size.

PPPPrrrriiiinnnntttt
Prints an open picture or Slide Show. For details, see "Printing Your Picture" on page 49 and "Printing 
Your Slide Show" on page 57.

SSSSeeeennnndddd    KKKKiiiidddd    PPPPiiiixxxx    PPPPaaaaggggeeee    bbbbyyyy    EEEEmmmmaaaaiiii llll
Opens the default email application and creates an email message with your Kid Pix artwork attached.

TTTThhhheeee    EEEEddddiiiitttt     MMMMeeeennnnuuuu

UUUUnnnnddddoooo////RRRReeeeddddoooo
Undo reverses the last change you made. Redo reverses the last Undo.

CCCCuuuutttt
Removes the currently selected object and places it on the Clipboard.

CCCCooooppppyyyy
Puts a copy of the currently selected object on the Clipboard.

PPPPaaaasssstttteeee
Pastes the object from the Clipboard.

SSSSeeeelllleeeecccctttt     AAAAllll llll     TTTTeeeexxxxtttt
Selects all the text inside the selected text box. (Applies only to text boxes.)

CCCChhhheeeecccckkkk    SSSSppppeeeellll llll iiiinnnngggg
Checks the spelling in all the text boxes in your picture. (Applies only to text boxes.) For details, see 
"Checking Spelling" on page 25.

CCCChhhheeeecccckkkk    SSSSppppeeeellll llll iiiinnnngggg    AAAAssss    YYYYoooouuuu    TTTTyyyyppppeeee
Provides a dynamic spelling check while you are typing. For more details, see "Checking Spelling As 
You Type" on page 26.

EEEEnnnnllllaaaarrrrggggeeee    ttttoooo    FFFFiiii llll llll     CCCCaaaannnnvvvvaaaassss
Enlarges the currently selected object to fill the whole drawing area.
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TTTThhhheeee    IIIImmmmppppoooorrrrtttt     MMMMeeeennnnuuuu

FFFFrrrroooommmm    iiiiPPPPhhhhoooottttoooo
Lets you browse through your iPhoto albums and import photographs you have stored in your iPhoto 
library. For details, see "Importing Pictures from iPhoto" on page 42.

FFFFrrrroooommmm    iiiiTTTTuuuunnnneeeessss
Lets you import sounds from your iTunes library. For details, see "Importing Sounds from iTunes" on 
page 43.

BBBBaaaacccckkkkggggrrrroooouuuunnnndddd
Lets you add a picture created in another program as a background for your Kid Pix picture. For details, 
see "Importing Backgrounds" on page 32.

GGGGrrrraaaapppphhhhiiiicccc
Lets you add a graphic created in another program to your Kid Pix picture. For details, see "Adding 
Pictures" on page 39.

MMMMoooovvvviiiieeee
Lets you import a QuickTime or MPEG movie to your Kid Pix picture. For details, see "Adding Movies" on 
page 40.

SSSSoooouuuunnnndddd
Lets you import and attach a sound from another source to your Kid Pix picture. For details, see 
"Adding Sounds" on page 40.

TTTThhhheeee    GGGGoooo    MMMMeeeennnnuuuu

GGGGoooo    ttttoooo    SSSSllll iiiiddddeeee    SSSShhhhoooowwww////PPPPaaaaiiiinnnntttt     ZZZZoooonnnneeee
Switches you from Paint Zone to Slide Show and back. For details, see "Going to Slide Show" on page 
51 and "Editing Pictures" on page 52.

TTTThhhheeee    PPPPaaaaiiiinnnntttt     ZZZZoooonnnneeee    MMMMeeeennnnuuuu

AAAAllllpppphhhhaaaabbbbeeeetttt     TTTTeeeexxxxtttt
Lets you insert the text you want to paint with using the Letters Wacky Paint option. For details, see 
"Alphabet Text Tool" on page 23.

SSSSaaaayyyy    IIIItttt     TTTThhhhiiiissss    WWWWaaaayyyy
Lets you teach Kid Pix how to pronounce words it does not know, like names and places. For details, 
see "Teaching Kid Pix to Pronounce" on page 27.
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FFFFllllaaaatttttttteeeennnn    TTTTeeeexxxxtttt
Makes text boxes a part of the background. You can flatten just the selected text box or all text boxes 
in the picture. For details, see "Working with Text Boxes" on page 24.

FFFFllllaaaatttttttteeeennnn    SSSSttttiiiicccckkkkeeeerrrrssss    &&&&    AAAAnnnniiiimmmmaaaattttiiiioooonnnnssss
Makes stickers and animations a part of the background. You can flatten just the selected object or all 
stickers and animations in the picture. For details, see "Stickers Library" on page 33, "Animations 
Library" on page 35.

FFFFllllaaaatttttttteeeennnn    MMMMoooovvvviiiieeeessss
Makes movies a part of the background. You can flatten just the selected movie or all of them. For 
details, see "Adding Movies" on page 40.

TTTThhhheeee    SSSSllll iiiiddddeeee    SSSShhhhoooowwww    MMMMeeeennnnuuuu

CCCChhhhaaaannnnggggeeee    BBBBaaaacccckkkkggggrrrroooouuuunnnndddd    CCCCoooolllloooorrrr
Lets you change the background color for your current Slide Show. For details, see "Background Color" 
on page 56.

CCCChhhhaaaannnnggggeeee    TTTTrrrraaaannnnssssiiiittttiiiioooonnnn    EEEEffffffffeeeeccccttttssss
Lets you customize the transition effect options for your Slide Show. For details, see "Transition 
Effects" on page 55.

LLLLooooaaaadddd    PPPPiiiiccccttttuuuurrrreeee
Places a picture in the selected slide of your Slide Show. For details, see "Loading Pictures" on page 52.

DDDDeeeelllleeeetttteeee    BBBBllllaaaannnnkkkk    SSSSllll iiiiddddeeeessss
Gets rid of blank slots in your Slide Show. For details, see "Deleting Blank Slides" on page 53.

TTTTuuuurrrrnnnn    MMMMaaaannnnuuuuaaaallll     AAAAddddvvvvaaaannnncccceeee    OOOOnnnn    oooorrrr    OOOOffffffff
Changes the transition settings of your Slide Show so that you need to click or use your keyboard to 
advance to the next slide. For details, see "Using Manual Advance" on page 57.

TTTThhhheeee    HHHHeeeellllpppp    MMMMeeeennnnuuuu

KKKKiiiidddd    PPPPiiiixxxx    UUUUsssseeeerrrr    GGGGuuuuiiiiddddeeee
Opens this User’s Guide in your default PDF viewer. For details, see "Getting Help" on page 11.

TTTTuuuurrrrnnnn    HHHHeeeellllpppp    TTTTaaaaggggssss    OOOOnnnn    oooorrrr    OOOOffffffff
Turns automatic help tags on or off. For details, see "Getting Help" on page 11.

KKKKiiiidddd    PPPPiiiixxxx    TTTTeeeecccchhhh    SSSSuuuuppppppppoooorrrrtttt
Connects your web browser to the Kid Pix Technical Support web page. For details, see "Getting 
Technical Support" on page 73. 
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KKKKeeeeyyyybbbbooooaaaarrrrdddd    SSSShhhhoooorrrrttttccccuuuuttttssss

Command + , Opens the Kid Pix Preferences dialog. For more information, see "Setting Up Kid 
Pix Preferences" on page 61.

Command + H Hides all the Kid Pix Deluxe 3X windows.

Command + 
Option + H

Hides all applications except Kid Pix Deluxe 3X. 

Command + Q Quits Kid Pix Deluxe 3X.

Command + N Creates a new Kid Pix picture or Slide Show. For details, see "Starting a New Picture" 
on page 47 and "Starting a Slide Show" on page 51.

Command + O Opens a Kid Pix picture or Slide Show. For details, see "Opening a Picture" on page 48 
and "Creating and Opening Slide Shows" on page 51.

Command + S Saves an open picture or Slide Show. For details, see "Saving a Picture" on page 47 
and "Saving Your Slide Show" on page 58.

Command + 
Shift + S

Opens the Kid Pix: Save As dialog for you to save an open Kid Pix picture or Slide 
Show to a selected location with the name you specify. For more information on 
saving, see "Save As" on page 66, "Saving a Picture" on page 47 and "Saving Your 
Slide Show" on page 58.

Command + 
Option + Shift 
+S

Opens the Kid Pix: Save as Template dialog for you to save an open Kid Pix 
picture as a template and add it to the Idea Machine. For more information, see 
"Saving a Picture as a Template" on page 48.

Command + 
Shift + P

Opens the Page Setup dialog, where you can define certain settings for printing. For 
more information, see "Page Setup" on page 67.

Command + P Opens the Print dialog for you to print the current picture or Slide Show. For details, 
see "Printing Your Picture" on page 49 and "Printing Your Slide Show" on page 57.

Command + Z Undoes or redoes the last action.

Command + X Cuts the currently selected object and places it on the Clipboard. 

Command + C Puts a copy of the currently selected object on the Clipboard. 

Command + V Pastes the object from the Clipboard.

Command + A Selects all the text inside a selected text box. For more information, see "Select All 
Text" on page 67. 

Command + L Enlarges the currently selected object to fill the whole drawing area. 

Command + ? Turns the automatic help tags off or on. For more information, see "Getting Help" on 
page 11.

Command Shows the menu bar.
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FFFFrrrreeeeqqqquuuueeeennnnttttllllyyyy    AAAAsssskkkkeeeedddd    QQQQuuuueeeessssttttiiiioooonnnnssss
The questions and answers in this chapter include:

• Why do some things become a part of the background, while others remain separate?

• How can I move a Kid Pix file from one computer to another?

• Can I save a Kid Pix picture or Slide Show in another format, so other people can see it?

• How can I set up multiple users and make the settings different for each one?

• How do I use the Sound Art tool?

• What is the difference between Rubber Stamps and Stickers?

• What’s the difference between animations and animated Wacky Paint or Moving Paints mode 
options?

Q: Why do some things become a part of the background, while others remain separate?

A: In Kid Pix, a picture is like a piece of paper with a layer of clear plastic over it. Things you add to 
the background cover each other, just as if you had painted them on a piece of paper. Objects like 
stickers, animations, sounds, movies, and text boxes float over the background, on the plastic layer. 
They remain independent until you flatten them. Flattening an object merges it into the background. 

You can pick up items on the plastic layer and move them, resize them, and (for animations, 
sounds, or movies) play them. 

Some actions cause things to flatten even if you do not flatten them yourself. For example, when 
you export a picture, the objects get flattened as a result, because the export format does not know 
how to display them otherwise.

Q: How can I move a Kid Pix file from one computer to another?

Q: Can I save a Kid Pix picture or Slide Show in another format, so other people can see it?

A: These two questions are related. 

To move a picture or Slide Show to another computer that has Kid Pix on it, save the picture to a 
mounted disk, or export the Slide Show as a “Slide Show To Go.” 

To move the picture or Slide Show to another computer without Kid Pix on it, export the file in a 
format the other computer can play. For more information, see "Exporting a Picture" on page 50 and 
"Exporting Your Slide Show" on page 58.

Q: How can I set up multiple users and make the settings different for each one?

A: Log in as KidPixAdmin to set up multiple users. Then log in as each user in turn and specify Kid 
Pix settings for that user. For details, see "Logging In As a New Kid Pix User" on page 63 and 
"Setting Up Kid Pix Preferences" on page 61.
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Q: How do I use the Sound Art tool?

A: The Sound Art tool paints abstract images that get their size and shape from the pitch and 
volume of sounds you put in through your computer’s sound input device. Talk or sing into your 
computer’s microphone, and the Sound Art tool will “paint” those sounds. 

To select the Sound Art tool, click the Painting Tools button and click the Sound Art tool in the 
tray. Then select the “Hands-free” or “Mouse-move” mode in the tool options tray. 

If you select the “Hands-free” mode, you can make noise into the microphone and Kid Pix will paint 
itself. If you select “Mouse-move”, you can direct the painting with the mouse and make noise at 
the same time to form the painting. For details, see "Using Painting Tools" on page 14.

Q: What’s the difference between Rubber Stamps and Stickers?

A: Rubber Stamps are pictures you “stamp” into your picture. They immediately get flattened 
into the background. You can edit rubber stamps using the Stamp Editor. You can’t edit the 
rubber stamps once you have added them to your picture. For details, see "Using Rubber Stamp 
Tools" on page 18. 

Stickers are pictures you add to your Kid Pix picture that remain independent objects. You can move 
and resize them unless you flatten them. For details, see "Stickers Library" on page 33.

Q: What’s the difference between animations and animated Wacky Paint or Moving Paints 
mode options?

A: Animations are stickers that move, like very small movies. Animations are played when you play 
your picture. Animations remain independent objects after you add them to your picture. You can 
move and resize them unless you flatten them. For details, see "Animations Library" on page 35. 

The Wacky Paint mode options of Paint Brush and the Moving Paints mode options of Spray 
Can are Painting Tools that paint with magical effects. After you paint with them, they animate for 
a short period, then get flattened into the background. You can’t move or change what you create 
with the Wacky Paint mode options of Paint Brush or the Moving Paints mode options of Spray 
Can tool the way you can with an animation. For more information, see "Using Painting Tools" on 
page 14.
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GGGGeeeettttttttiiiinnnngggg    TTTTeeeecccchhhhnnnniiiiccccaaaallll     SSSSuuuuppppppppoooorrrrtttt
TTTToooo    ggggeeeetttt     TTTTeeeecccchhhhnnnniiiiccccaaaallll     SSSSuuuuppppppppoooorrrrtttt ::::

• Choose Kid Pix Tech Support from the Help menu. Your web browser will take you to the Kid 
Pix Technical Support page. 

If you cannot launch Kid Pix, you can go to The Software MacKiev Technical Support page by copying 
the following address into your web browser www.mackiev.com/support.html. 
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Firehose Screen Eraser 21
Fit to page 49
Flash exporting 50
Flatten Movies 40, 69
Flatten Stickers & Animations 34, 36, 69
Flatten Text 24, 69
Flattening

animations 36
frequently asked questions 71
movies 40
stickers 34
text boxes 24

Flipping
animations 36
rubber stamps 19
stickers 34

Font
changing 25
setting 61

Font size

changing 25
setting 62

Formatting text 25
Free Cutout 29
Frequently Asked Questions 71
Full page

printing picture as 49
printing Slide Show as 57

G
Getting

Coaching Help 11
help 11
help tags 11
started 7
User’s Guide 12

GIF pictures
adding 39
importing as background 32

Go to Paint Zone 52, 68
Go to Paint Zone button 52
Go to Slide Show 51, 68
Grab tray

copy 28
cut 28
paste 28

Graphic formats 50

H
Help

button 11
coaching 11, 62
extended 11
getting 11
menu 11, 69
tags 11, 62, 70

Help tags
command 69
setting up 62
shortcut 70

Hide Kid Pix 66, 70
Hide Others 66, 70

I
Idea Machine 47, 66
Import Background 32, 68
Import From iPhoto 42, 68
Import From iTunes 43, 68
Import Graphic 39, 68
Import menu 68
Import Movie 40, 68
Import Sound 38, 40, 68
Install Kid Pix CD Contents 8, 65
Installing Kid Pix 7
Italic font style 25
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J
JPEG pictures

adding 39
exporting as 50
importing as background 32

K
Keyboard shortcuts 70
Kid Pix

about 65
customizing 61
getting started 7
getting technical support 69, 73
installing 7
launching 7
libraries 30
logging in 8
menus 65
preferences 61
registering 65
removing 12
User’s Guide 12, 69

Kid Pix movie
skip 62

KidPixAdmin 63, 71

L
Landscape orientation 58
Launching Kid Pix 7
Letters Wacky Paint option 23
Libraries 30
Library

buttons 30
trays 30

Line
curved 13
freestyle 13
straight 13
thickness 13

List of Voices pop-up menu 26
Load picture icon 52
Loading

pictures 52, 69
Log In as New Kid Pix User 63, 65
Logging in Kid Pix 8
Login dialog

skip 62, 63

M
Marker 13
Mega Mixer 18
Menus

in Kid Pix 65
using 11

Mini Eraser 21
Mixer Wand 18
Mixers

effects 18
sizes 18
tray 18

Movies
adding 40
deleting 28, 40
flattening 40
moving 28, 40
playing 41
playing frame-by-frame 41
playing in a loop 41
resizing 40
stop playing 41

Moving
animations 36
movies 28, 40
objects with Grab tool 28
pictures in Slide Show 52
stickers 33
text boxes 24

MPEG movies 40, 68
Multiple users

delete 63
frequently asked questions 71
setting up 63

N
Naming

pictures 47
Slide Shows 58

New
command 66
Create New picture button 47
Slide Show button 51

Normal Mode 64

O
Open 48, 52, 66, 70
Open Sound Recording Tray button 37
Opening

pictures 48
Slide Show 52

P
Page advance options 54

customizing Slide Show 54
Key Down 55
Mouse Click 55
Read Text Done 55
Timer 55

Page Setup 67, 70
Paint Brush

Realistic Paint 14
Wacky Paint 14

Paint Bucket Tools button 16
Paint Buckets

Blend of Colors 17
in Stamp Editor 19
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Multicolor Pattern 17
solid 17
tray 16

Paint Zone 9
Paint Zone menu 68
Painting Tools

button 14
modes 14
sizes 14
texture 16, 20
tray 14

Paste 22
Paste button in tray 22, 28
Paste command 53, 67
Pasting

in Slide Show 53
text 22
with Grab tool 28

PDF files
adding 39
exporting 50
importing as background 32

Pencil
for Rubber Stamps 19
tool 13

Photographs
adding 39
importing 42

PICT pictures
adding 39
adding as backgrounds 32
exporting as 50

Pictures
adding 39
deleting from Slide Show 53
exporting 50
exporting to iMovie 50
loading into Slide Shows 52
moving in Slide Show 52
moving to another computer 71
naming 47
new 47
opening 48
pasting in Slide Show 53
playing 48
printing 49
saving 47
sending 67

Play
picture 48
Slide Show 57

Polygon Cutout 29
Portrait orientation 58
Preferences 61

command 65
setting 61

Print

button 49, 57
command 67
shortcut 70

Printing
on separated pages 49, 57
orientation 58
picture 49
Slide Shows as cards / booklets 58
Slide Shows as comic books 58
Slide Shows as storybook 58
Slide Shows as thumbnails 58

Pronunciation
learning Kid Pix 27

Q
QuickTime

exporting as 50
exporting Slide Shows as 59
movie 50

Quit 9, 66, 70
Quit button 9, 66

R
Redo command 67, 70
Registration 65
Removing Kid Pix 12
Repeat many times

for backgrounds 32, 43
for pictures 39

Resizing
animations 36
movie 40
stickers 33
text boxes 24

Restore Original button 19
Reverse print 49
Reversing actions 21, 67, 70
Rotating rubber stamps 19
Rubber Stamp Editor 19
Rubber Stamp Tools button 18
Rubber stamps

adding 18
and stickers 72
changing 19
changing color 19
drawing 19
editing 19
erasing 19
flipping 19
restoring 19
rotating 19
sizes 19
tray 18

S
Save As command 48, 66
Save as Template command 66
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Saving
pictures 47
Slide Shows 58

Say It This Way 27, 68
Scrolling Slide Show 53
Select All Text 67, 70
Send by Email 67
Sending artwork 67
Services 65
Setting up

multiple users 63
preferences 61

Shortcuts keyboard 70
Show All 66
Shrink/stretch to fill canvas

for backgrounds 32, 43
for pictures 39, 43

skip
Kid Pix movie 62

Skip Kid Pix movie 62
Skip the Login dialog 62
Slide Show

audio options 56
background color 56
creating animations 59
creating new 51
customizing 54
Customizing Slide Show Effects button 54
deleting blank slides 53
exporting 58
exporting as QuickTime 59
exporting as Slide Show To Go 59
exporting to iMovie 59
Go to Slide Show button 51
loading pictures 52
menu 69
moving to another computer 71
naming 58
opening 52
page advance options 54
playing 57
printing 57
saving 58
scrolling 53
stop playing 57
transition effects 56
tray 51

Slide Show To Go
exporting 59, 71
frequently asked questions 71

Slide Shows 10, 51
Slides

deleting 53
loading 52
moving 52
pasting 53

Small Kids Mode
activating 64
printing in 49

text in 23
turning on or off 65

Sound Art tool
frequently asked questions 72
Hands-free mode 15
Mouse-move mode 15
Painting Tools 15

Sound formats 38, 40
Sound Recording Tray

close button 37
open button 37

Sounds
adding 37
importing 38, 40
in Slide Show 56
Library 30
library button 37
recording 37
removing from My Sounds 32, 38
removing from picture 31, 37
tray 37

Spelling
checking 25, 67
checking as you type 26, 67

Spray Can
Moving Paints mode 16
Paint Shapes mode 16

Square Cutout 29
Stamp Editor 19
Standalone Page 50
Starting

new pictures 47
Slide Show 51
with the Idea Machine 47

Stickers
adding 33
copying 28
deleting 28, 34
flattening 34
flipping horizontally 34
flipping vertically 34
Library 30
library button 33
moving 28, 33
resizing 33
rubber stamps 72
tray 33

Stop Slide Show 57
Storybook printing 58
System requirements 6

T
Technical Support 73
Text

aligning 25
centering 25
changing size 25
changing style 25
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check spelling 25, 67
check spelling as you type 26, 67
copying 22
cutting 22
in Small Kids Mode 23
options in Preferences 61
pasting 22
playing 56
Read Text Done 55
reading out loud 26
selecting all 67, 70
setting font 62
setting font size 62
tray 22, 25

Text boxes
copying 28
deleting 24, 28
flattening 24
formatting text 25
moving 24, 28
moving off page 25
resizing 24

Text style 25
Text Tools button 22, 25
Text-to-Speech

changing voice for 26
pronunciation 27
setting up 62

Thumbnail printing 58
Transition Effects 55, 69
Trash Can

in Grab tool tray 28
in Slide Show 53
in Sounds tray 32, 38

Turn Manual Advance On or Off 57, 69
Turn off

Login dialog 63
Turn Small Kids Mode On or Off 49, 64, 65

U
Underline font style 25
Undo 21, 67, 70
Undo Guy 21

V
Video Standard 50, 59

W
Wacky Paint mode

and animations 72
painting 15
text 23
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